Caliper Life Sciences Factory Warranty

Caliper® Life Sciences, Inc. warrants your Caliper-manufactured equipment, including hardware, software, and firmware, and the Caliper-purchased controller (if applicable), against defects in material and workmanship for a period of one (1) year from the date of shipment.

What is Included

- On-site service is provided during normal business hours, your local time from 8AM through 5PM, excluding holidays. A Caliper representative will make his/her best effort to be on-site within three business days.
- Unlimited emergency on-site repair services, parts, and software corrections that affect original functional/design specifications, and their associated labor and travel expenses.
- Unlimited access to Caliper’s Technical Support Center during the warranty period, which provides troubleshooting, repair instruction, service dispatching, replacement part information, and shipment.
- One pre-scheduled on-site Preventive Maintenance and Diagnostic Servicing (PM) performed by a Caliper Field Service Engineer. A PM visit includes the replacement of Limited-Life parts exposed to fluidics, such as syringes, valves, seals, and fittings. The Caliper Field Service Engineer will perform a comprehensive analysis and testing to confirm the equipment is left operating to factory specifications.
- Scheduling of the PM within the warranty period is flexible and determined by the customer after notification by the Caliper Field Service Engineer. The servicing is typically scheduled six months after the equipment installation, but equipment usage rate and availability may cause the date to vary.
- A completed Caliper Field Service Report provides thorough documentation of all maintenance and service work performed by the Caliper Field Service Engineer during the on-site visit. (Exception: Documentation is not provided when Caliper provides service via telephone, fax, or modem.)
- Limited-Life parts are covered for thirty (30) days after installation and are replaced once during the PM. See description of Limited-Life Parts later in this warranty.
- Cosmetic surfaces are warranted for thirty (30) days from date of installation.

Customers must use the Caliper-purchased controller. If customers fail to use Caliper’s controller, field service charges incurred during the workstation installation process will be charged at Caliper’s current rates. These charges include round-trip travel and on-site installation time, transportation expenses, and per diem living expenses.

Any defects covered by this warranty shall be corrected by replacing or repairing the affected item, at Caliper’s option. Parts replaced during the warranty period will be covered for the remaining term of the original warranty, or for thirty (30) days from time of replacement, whichever is longer. Such replacement parts may, at Caliper’s option, be new or remanufactured. All parts removed from warranted equipment become the property of Caliper.

Caliper reserves the right to satisfy its warranty obligations in full by refunding the purchase price minus any service, validation, or travel charges of any defective product.
Customer Responsibilities

- The equipment must be used under normal installation and application conditions as described in the User’s Manual.
- The equipment must be maintained as described in the User’s Manual.
- Reasonable precautions should be taken to keep caustic atmospheric conditions, chemical spills, and biological and radioactive contamination from rendering the equipment irreparable, which would void this warranty. See the Hazardous Limitation Statement for further details.
- Caliper Automation Certified Disposables are required for proper operation of all applicable products.
- The customer is responsible for making the equipment available for a PM during the warranty period. Caliper will not be held liable for a missed PM due to restricted access to the equipment during the coverage period.
- When Caliper provides telephone, fax, or modem support, the customer is responsible for completing any necessary documentation of the service.
- If the customer maintains a change control/validation log book as a permanent record, then he/she is responsible for entering all service documentation into this log.
- Customers must perform the appropriate level of revalidation required as a result of the maintenance or service provided.
- Data back-up is the responsibility of the customer. Caliper will not be held liable for loss of data due to failure of the PC (controller) hardware or software.
- Customer will make the equipment available for emergency and preventative maintenance servicing upon arrival of a Caliper Field Service Engineer.

Exclusions

Any alteration of the hardware or software on Caliper products covered under this warranty, that are not performed by Caliper or an approved Caliper vendor, will void this warranty.

- Product that has been subject to misuse, accident, negligence or improper transportation, handling, installation, storage, use, maintenance, or application is not covered under this warranty.
- Caliper Automated Certified Disposables are recommended for proper operation. Repair services required for inaccurate accuracy, precision, or operation due to the use of non-Caliper Automated Certified Disposables will void this warranty and be invoiced at Caliper’s current field service rates.
- This warranty is intended to cover equipment manufactured by Caliper. Equipment purchased from other vendors is not covered by this warranty.
- Caliper will provide service for Caliper supported software and hardware platforms only. A Caliper representative has the right to remove any unsupported software from the controller when troubleshooting to eliminate any possible software conflicts it may have on Caliper equipment. Service due to unsupported software loaded on the controller will be invoiced at Caliper’s current field service rates.
• Limited-Life parts are covered for thirty (30) days after installation and are replaced once during the PM. Beyond this replacement, these parts are available at current list prices and are designed for replacement by the customer. See the description of Limited-Life Parts below.

• Damage to Limited-Life parts caused by insufficient maintenance or cleaning practices, or abnormal applications are not covered under this contract. If these situations are diagnosed, charges are at current list prices for parts and current service rate structure for labor and travel.

• Application and chemistry support is not included.

• Software releases that contain new product features and functionality are offered for sale by Caliper and are not included under this program.

• This warranty applies only to the original users and delivery locations. It is not transferable to other users or locations without pre-approval from Caliper.

**Limited-Life Parts**

Limited-Life Parts are any parts that are exposed to solvents, reagents, or samples. Such parts include, but are not limited to: syringes, valves, seals, fittings, and finger pads. These parts are warranted to be functional at the time of installation and are covered for thirty (30) days after installation. Limited-Life Parts are routinely replaced by Caliper Field Service Engineers during a PM visit or during Caliper Repair Depot servicing. Otherwise, these parts are available from Caliper at current list prices and are designed for replacement by the customer.

**Repair Authorization**

In servicing situations requiring the return of equipment to Caliper, equipment must be returned to Hopkinton, MA, USA, or a facility designated by Caliper. The customer shall prepay charges for equipment returned to Caliper, with Caliper paying for equivalent return shipment to the customer.

A Returned Material Authorization (RMA) must be obtained for any equipment being returned to Caliper. Contact the Caliper Technical Support Center by telephone at either 508-435-9761 or 1-877-LabChip for LabChip products only, via the Internet at techsupport@caliperLS.com, or by fax at 508-435-0950 before returning any equipment to Caliper. Additionally, customers are required to complete a Caliper Chemical Questionnaire prior to the issuance of an RMA. All equipment returned to Caliper must first be decontaminated to meet Caliper and United States Department of Transportation procedures and standards. These procedures provide for the safety of Caliper receiving and repair personnel.

**Hazardous Limitation Statement**

At no time will Caliper personnel perform service on unsafe equipment, perform service in unsafe environments or decontaminate equipment to make it safe.

Caliper is not licensed to accept products that have been exposed to radioactive materials.

Prior to the performance of any service work, Caliper personnel will evaluate the condition of the equipment and the environment in which the equipment is located.
After evaluation and discussion with the customer, Caliper commits to the following:

- When the environment and equipment are determined to be free of chemical, radioactive, and bio-hazardous materials by Caliper personnel, servicing will be performed.

- When the equipment and/or the environment are determined to be hazardous by Caliper personnel, Caliper reserves the right to refuse servicing the equipment. One of two situations will then occur:
  1. The customer will decontaminate the equipment and/or the environment in which the equipment is located to the satisfaction of Caliper personnel, prior to Caliper servicing.
  2. The customer decides not to decontaminate the equipment and/or the environment, and takes responsibility to service the equipment themselves through on-site, verbal instruction from Caliper personnel.

Parts Availability and On-Going Support

Caliper provides support for its products for a period of five (5) years after a product is no longer available for purchase.

No Other Warranties

CALIPER SPECIFICALLY DISCLAIMS ANY AND ALL OTHER PROMISES, REPRESENTATIONS, AND WARRANTIES, EXPRESSED OR IMPLIED. THIS INCLUDES, BUT IS NOT LIMITED TO, THE PRODUCT’S CONDITION, ITS CONFORMITY TO ANY DESCRIPTION OR REPRESENTATION, THE EXISTENCE OF ANY LATENT OR PATENT DEFECTS, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL CALIPER BE LIABLE, WHETHER ARISING IN CONTRACT, TORT (INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER. IN NO EVENT SHALL CALIPER’S LIABILITY EXCEED THE PURCHASE PRICE FOR THE PRODUCT.
Caliper Life Sciences Software License Agreement

Thank you for purchasing our products. PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE OPENING THE PACKAGE CONTAINING THE SOFTWARE MEDIA, THE COMPUTER SOFTWARE CONTAINED THEREIN, AND THE ACCOMPANYING USER DOCUMENTATION (HEREIN REFERRED TO AS THE “PROGRAM”). THE PROGRAM IS COPYRIGHTED AND LICENSED, NOT SOLD. BY OPENING THE PACKAGE CONTAINING THE PROGRAM, YOU ARE ACCEPTING AND AGREEING TO THE TERMS OF THIS LICENSE AGREEMENT. IF YOU ARE NOT WILLING TO BE BOUND BY THE TERMS OF THIS LICENSE AGREEMENT, YOU SHOULD PROMPTLY RETURN THE PACKAGE IN UNOPENED FORM, AND YOU WILL RECEIVE A REFUND. THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE SOFTWARE AGREEMENT CONCERNING THE PROGRAM BETWEEN YOU AND CALIPER® LIFE SCIENCES, INC. (REFERRED TO AS “LICENSOR”), AND IT SUPERSEDES ANY PRIOR PROPOSAL, REPRESENTATION, OR UNDERSTANDING BETWEEN THE PARTIES.

1 License Grant.
The Licensor hereby grants to you, and you accept, a nonexclusive license to use the Software Media and the computer programs contained therein in machine-readable, object code form only, collectively referred as the “Program”, and to use the accompanying User Documentation, only as authorized in this License Agreement. The Software may be used only on a single computer owned, leased, or otherwise controlled by you; or, in the event of the inoperability of that computer, on a backup computer selected by you. If the Software is an Applications Package, you may use it on a single, local system Controller. Neither concurrent use on two or more computers nor use in a local area network or other network is permitted without separate authorization and the payment of other license fees. You agree that you will not assign, sublicense, transfer, pledge, lease, rent, or share your rights under this License Agreement, except that you may permanently transfer all of your rights under this License Agreement, provided that you retain no copies, you transfer all of the Software (including all related media and printed materials and any upgrades), and the transferee agrees to the terms of this License Agreement. You agree that you may not reverse assemble, reverse compile, or otherwise translate the Software.

Upon loading the Software into your computer, you may retain the Software Media for backup purposes. In addition, you may make one copy of the Software on a second media for the purpose of backup in the event the Software Media is damaged or destroyed. Any such copies of the Software shall include Licensor’s copyright and other proprietary notices. Except as authorized under this paragraph, no copies of the Program or any portions thereof may be made by you or any person under your authority or control.
2 **Licensor’s Rights.**
The Licensor has invested significant time and money in developing products to make your work easier. The Licensor’s products contain important trade secrets, which must be used in confidence. You acknowledge and agree that the Software and the User Documentation are proprietary products of the Licensor and are protected under U.S. copyright law. You further acknowledge and agree that all right, title, and interest in and to the Program, including associated intellectual property rights, are and shall remain with the Licensor. This License Agreement does not convey to you an interest in or to the Program, but only a limited right to use revocable in accordance with the terms of this License Agreement. In the event of a breach, the Licensor reserves the right to seek equitable relief.

3 **License Fees.**
The license fees paid by you are paid in consideration of the licenses granted under this License Agreement.

4 **Term.**
This License Agreement is effective upon your opening of this package and shall continue until terminated. You may terminate this License Agreement at any time by returning the Program, Software Media, and all copies thereof and extracts therefrom to the Licensor. The Licensor may terminate this License Agreement upon the breach by you of any term hereof. Upon such termination by the Licensor, you agree to return to the Licensor the Program, Software Media, and all copies and portions thereof.

5 **Limited Warranty.**
The Licensor warrants, for your benefit alone, for a period of 90 days from the date of the commencement of this License Agreement (referred to as the “Warranty Period”) that the Software Media in which the Software is contained are free from defects in material and workmanship. If, during the Warranty Period, a defect in the Program or Software Media arises, you may return the Program to the Licensor for either replacement or, if so elected by the Licensor, refund of amounts paid by you under this License Agreement. You agree that the foregoing constitutes your sole and exclusive remedy for breach by the Licensor of any warranties made under this Agreement. EXCEPT FOR THE WARRANTIES SET FORTH ABOVE, THE PROGRAM, SOFTWARE MEDIA, AND THE SOFTWARE CONTAINED THEREIN, ARE LICENSED “AS IS,” AND THE LICENSOR DISCLAIMS ANY AND ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

6 **Limitation of Liability.**
The Licensor’s cumulative liability to you or any other party for any loss or damages resulting from any claims, demands, or actions arising out of or relating to this Agreement shall not exceed the license fee paid to the Licensor for the use of the Program. In no event shall the Licensor be liable for any indirect, incidental, consequential, special, or exemplary damages or lost profits, even if the Licensor has been advised of the possibility of such damages. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
7 **Software Updates.**
Software updates are created periodically. The Licensor is not responsible for your use of superseded, outdated or uncorrected versions of Software.

8 **Governing Law.**
This License Agreement shall be construed and governed in accordance with the laws of the Commonwealth of Massachusetts. Any dispute will be resolved in the state and federal courts of the Commonwealth of Massachusetts.

9 **Severability.**
Should any term of this License Agreement be declared void or unenforceable by any court of competent jurisdiction, such declaration shall have no effect on the remaining terms hereof.

10 **No Waiver.**
The failure of either party to enforce any rights granted hereunder or to take action against the other party in the event of any breach hereunder shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the event of future breaches.
Preface

Copyright

This manual is published by Caliper Life Sciences, Inc., 68 Elm Street, Hopkinton, MA 01748 USA. Copyright 2000 - 2004, Caliper Life Sciences, Inc. All rights reserved. Reproduction by any means or in any form of this manual or the products it describes is prohibited.

Trademarks

Caliper, CLARA, and Twister are registered trademarks of Caliper Life Sciences, Inc. The Caliper logo and “Working Innovation”; iLink; and XP Robot are trademarks of Caliper Life Sciences, Inc. Microsoft, Windows, and Windows NT are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other trademarks and registered trademarks are the property of their respective holders.

Contents

The information in this manual may contain typographical errors or technical inaccuracies and is subject to change without notice. Modifications may also be made to the product described in this manual at any time.

Statement of Proper Use

The iLink PRO software is designed to program, sequence or schedule, and execute methods for automated robotic systems that use Caliper’s instrument resource kits. iLink PRO’s graphical interface and drag-and-drop programming allow easy creation or modification of methods. In addition, the easy-to-use Run Method window provides a simple interface for system operators.

WARNINGS

- To reduce the risk of electric shock, do not remove the cover. No user serviceable parts are inside. Refer to qualified service personnel.
- Use this product only in the manner described in this manual. When used in a manner other than specified, the safety precautions may be impaired.
Contact Us

If you have a question about a product that is not answered in this manual or online Help, or if you need assistance regarding this product, please contact the Caliper Technical Support Center from 8:00 A.M. to 8:00 P.M., Eastern Time, Monday through Friday:

Phone:  (508) 435-9761;  
1-877-LabChip for LabChip products only
Fax:  (508) 435-0950
Email:  techsupport@caliperLS.com
Internet:  www.caliperLS.com

For support in Europe contact Caliper Life Sciences LTD, Runcorn, UK +44-1928-711448 or fax +44-1928-791228. For more information contact your local Caliper representative.

Before you call, you should have the following information available for the technical representative:

• Product serial number
• Software version (found by choosing About from the main Help menu)
• If applicable, the error number shown.

Product Service and Customer Support Plans

Caliper offers a full range of services to ensure your success. From our original factory warranty through a comprehensive line of customer support plans, Caliper offers you Field Service Engineers and in-house Specialists who are dedicated to supporting your hardware, software and application development needs.

Call:  (508) 435-9761
Fax:  (508) 435-0950
Email:  service.plans@caliperLS.com

Our programs can include such useful services as:

• Preventive maintenance
• Diagnostic servicing performed on-site by Caliper field service engineers
• Extended use of the Caliper Technical Support Center
• Use of a software program for automated, remote troubleshooting
• Software updates
• Parts, labor, and travel expense coverage
• Other customized services upon request
Training For Your Product

Contact the Caliper Center for Training and Development for information about the availability of training courses for your product:

Call:  (508) 497-2634
Fax:   (508) 435-3439
Email: training@caliperLS.com

FCC

This device complies with part 15 of the FCC (United States Federal Communications Commission) Rules. Operation is subject to the following two conditions:

• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.

CE

This device complies with all CE rules and requirements.

NOTE

Changes or modifications to this equipment not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Table of Symbols

Table 1 contains symbols that identify particularly important information and alert you to the presence of hazards. Some of these symbols may not appear in this manual or on the product it describes:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️</td>
<td>DANGER: An imminently hazardous situation, which, if not avoided, will result in death or serious injury.</td>
</tr>
<tr>
<td>⚠️⚠️</td>
<td>WARNING: A potentially hazardous situation, which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Note" /></td>
<td><strong>NOTE:</strong> A cautionary statement; an operating tip or maintenance suggestion; may result in instrument damage if not followed.</td>
</tr>
<tr>
<td><img src="image" alt="Voltage" /></td>
<td>Hazardous voltage; risk of shock injury.</td>
</tr>
<tr>
<td><img src="image" alt="Crush" /></td>
<td>Crush hazard. Risk of body parts, hair, jewelry, or clothing getting caught in a moving part.</td>
</tr>
<tr>
<td><img src="image" alt="Puncture" /></td>
<td>Risk of puncture injury.</td>
</tr>
<tr>
<td><img src="image" alt="Eye" /></td>
<td>Risk of eye injury; wear safety glasses.</td>
</tr>
<tr>
<td><img src="image" alt="Fire" /></td>
<td>Risk of fire.</td>
</tr>
<tr>
<td><img src="image" alt="Poison" /></td>
<td>Risk of poison.</td>
</tr>
<tr>
<td><img src="image" alt="Explosion" /></td>
<td>Risk of explosion.</td>
</tr>
<tr>
<td><img src="image" alt="Fumes" /></td>
<td>Hazardous fumes.</td>
</tr>
<tr>
<td><img src="image" alt="Surface" /></td>
<td>Hot surface; risk of burns.</td>
</tr>
<tr>
<td><img src="image" alt="Laser" /></td>
<td>Laser light; avoid exposure. Risk of eye injury.</td>
</tr>
<tr>
<td><img src="image" alt="Lifting" /></td>
<td>Lifting hazard. May result in injury.</td>
</tr>
<tr>
<td><img src="image" alt="Ground" /></td>
<td>Protective ground symbol.</td>
</tr>
<tr>
<td><img src="image" alt="Euro" /></td>
<td>Ground symbol.</td>
</tr>
<tr>
<td><img src="image" alt="CE" /></td>
<td>CE compliance mark.</td>
</tr>
<tr>
<td><img src="image" alt="High" /></td>
<td>Signifies that the unit has passed safety tests for grounding, power line transience, and current leakage.</td>
</tr>
</tbody>
</table>
Table 1. Important Symbols (Continued)

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Input Icon]</td>
<td>Input.</td>
</tr>
<tr>
<td>![Output Icon]</td>
<td>Output.</td>
</tr>
</tbody>
</table>

Equipment labels are color coded:
- **Yellow** Caution, risk of danger
- **Red** Stop
- **Blue** Mandatory action
- **Green** Safe condition or information
- ![Helpful Icons] Helpful hints, additional information
# Table of Contents

Caliper Life Sciences Factory Warranty ................................................................. 2  
Caliper Life Sciences Software License Agreement ................................................. 6  
Preface ....................................................................................................................... 9  
Introduction ............................................................................................................... 19  
  Intended Audience ................................................................................................. 19  
  Training Required by System Integrators ............................................................... 20  
  Training Required by System Operators ................................................................. 20  
Features and Functions ........................................................................................... 21  
  iLink PRO Terminology for System Operators ....................................................... 21  
    Instrument Control Program (ICP) ....................................................................... 21  
    Instrument Method ............................................................................................. 21  
    iLink PRO Method ............................................................................................. 22  
    iLink PRO Method Set ....................................................................................... 22  
    Parameters ......................................................................................................... 22  
    Variables ........................................................................................................... 22  
    Materials ............................................................................................................ 23  
    Alarms ................................................................................................................ 23  
    Notifications ..................................................................................................... 23  
  Remote and Standalone Modes .............................................................................. 24  
  iLink PRO Terminology for System Integrators ..................................................... 24  
    Adapter Software ................................................................................................ 24  
    System Setup ..................................................................................................... 24  
    Resource Types .................................................................................................. 25  
    Operation Parameters ....................................................................................... 25  
    Variables ........................................................................................................... 27  
    Parameters ......................................................................................................... 27  
    Material Definitions ........................................................................................... 28  
    Conditional Execution .................................................................................... 28  
    Run-Time Conditional Execution ....................................................................... 29  
    Concurrency ....................................................................................................... 29  
    Drive Mode ........................................................................................................ 29  
    Scheduling/Sequencing .................................................................................... 30  
    Restacking ......................................................................................................... 30  
    Lids ..................................................................................................................... 31  
    Instrument .ini Files ........................................................................................... 31  
Robot Software Terminology .................................................................................. 32  
  Positions ............................................................................................................... 32  
  Paths ...................................................................................................................... 34  
  Robot Procedures ................................................................................................ 34  
  Robot Files ........................................................................................................... 35  
  Remote and Standalone Modes ............................................................................. 36  
Software Architecture ............................................................................................... 36
Integrating the System

Overview
Opening the System Setup Window
Adding the Resources
Saving the System Setup
Running an Instrument on a Remote Computer
  Set Up DCOM for the Instrument Software
  Turn Off Windows Firewall on BOTH Computers
  Create a new Registry Key on the Remote Computer
  Registering AdapterInterface22.tlb
  Set up More Lenient Security Policy on BOTH Computers
  Turn Off Simple File Sharing on BOTH Computers
  Adding the Remote Resource to iLink PRO

Teaching the Robot

Overview
Teaching the Twister II Storage Racks
Teaching the Instrument Positions
Example: Sciclone Position Numbers and Locations

Developing Methods

Overview
Creating a New Method
  Opening a New Method
  Creating the Initial Material Layout
  Example: Adding Multiple Materials to Twister II Racks
  Defining Variables for the Method
  Defining Parameters for the Method
  Choosing the Method Scheduling Options
  Adding Moves to the Method
  Example: Moving a Plate from a Rack with Multiple Materials
  Adding Resource Operations to the Method
  Adding Resource Comments to a Method
  Conditionally Executing an Instruction
  Changing the Instruction Duration
  Executing an Instruction Only During Specific Runs
  Creating New Data Configurations
  Choosing the Data Configurations for a Method

Opening a Method
Editing a Method
  Copying an Instruction in a Method
  Pasting an Instruction into a Method
  Deleting an Instruction from a Method
  Changing the Parameters for an Instruction
  Adding Additional Materials to a Method after Saving
  Deleting Materials from a Method

Saving a Method
Setting Up the Materials in a Storage Resource
Viewing Gantt Charts ................................................................. 112
Opening a Scheduled Method in the Chart Viewer .................. 113
Comparing Methods in the Chart Viewer ............................... 114
Changing a Resource’s Color ............................................... 114
Closing a Gantt Chart ............................................................. 115
Changing the Chart Viewer Settings ....................................... 115
Adjusting the Method ............................................................ 117
Setting the iLink PRO Options ................................................. 118
  Setting the General Options .............................................. 118
  Setting the Simulation Mode Options ............................... 119
  Setting Up the Alarm Notifications .................................. 121
Closing the Method Editor Window ....................................... 123
Importing/Exporting Methods .............................................. 124
Running Methods from the Method Editor Window ................ 124
Viewing the Editor Log ......................................................... 125

Developing Method Sets ......................................................... 126
  Overview ........................................................................... 126
  Creating a New Method Set .............................................. 127
  Editing an Existing Method Set ....................................... 129
  Saving a Method Set ........................................................ 130
  Closing the Method Editor Window .................................. 130

Running a Method ................................................................. 131
  Overview ........................................................................... 131
  Turning the System ON .................................................... 131
  Starting the iLink PRO Software ....................................... 132
  Opening a Method or Method Set ...................................... 133
  Loading the Materials into the System ............................. 135
    Placing the Racks onto the Twister II Pods ..................... 138
  Changing Parameters ....................................................... 140
  Starting the Run ............................................................... 141
  Pausing the Run .............................................................. 143
  Resuming the Run ........................................................... 143
  Stopping the Twister II Robot Immediately ....................... 144
  Finishing the Current Run ................................................ 144
  Ending the Run Immediately ............................................ 144
  Viewing the iLink PRO Runtime Log Files ......................... 145
  Closing the iLink PRO Software and Turning the System OFF .......................................................... 145

Twister II Hardware ............................................................... 146
  Overview ........................................................................... 146
  Robot Parts and Functions ................................................ 147
    Robot Axes ...................................................................... 147
    Robot Canister ........................................................... 149
  Pod Parts and Functions .................................................. 150
    Rack Position Numbers ................................................ 150
    Exterior Front View .................................................... 151
    Exterior Rear View .................................................... 152
Introduction

The iLink PRO software makes it easy to integrate and operate an automated robotic system that uses Caliper’s resource kits to integrate instruments into a system controlled by iLink PRO.

The iLink PRO software has a simple operator interface, making it easy for the operator to start the runs. The flexibility of the iLink PRO software allows many different types of instruments such as readers, washers, liquid handlers, etc. to be integrated and controlled from one application.

The iLink PRO software enables the system integrator to create methods that use a robot to move plates between the instruments in the system. The iLink PRO methods specify the instrument methods to execute on the plates or enable the system operator to choose the instrument methods when the run begins.

This manual describes the iLink PRO software, the Twister II Robot software for iLink PRO, and the Twister II hardware. For information on the hardware or software for other instruments in your system, see the documentation that accompanied the specific instrument.

Intended Audience

This manual is intended to be used by the system operator and by the system integrator.

The system operator is responsible for running the iLink PRO methods. This manual contains the information and instructions for the system operator to set up for and run the methods that the integrator has created.

The system integrator is responsible for setting up the iLink PRO software, integrating the instruments and resources into the system, updating existing resources, creating instrument methods, and creating iLink PRO methods and method sets. The integrator is usually either a specially-trained Caliper Field Service Engineer or a person who has completed the Caliper Integration training and is familiar with automated systems. This manual includes set up, operating and troubleshooting procedures for the integrator.

It is the integrator’s responsibility to ensure they have the proper training before following the procedures in this manual.
Training Required by System Integrators

This guide assumes that the system integrator has completed system integration training provided by Caliper and is familiar with:

- The standard Microsoft® Windows® conventions
- The specific resources used in the system
- The ICPs (Instrument Control Programs) used in the system
- The instrument methods that will be used in each iLink PRO method

If you have not been properly trained or are not familiar with any of the items in the list above, it is strongly recommended that you obtain the required training before operating the system.

Training Required by System Operators

This guide assumes that the system operator is familiar with:

- The standard Microsoft® Windows® conventions
- The specific instruments used in the system
- The ICPs (Instrument Control Programs) used in the system
- The instrument methods that will be used in the iLink PRO method

If you have not been properly trained or are not familiar with any of the items in the list above, it is strongly recommended that you obtain the required training before operating the system.
Features and Functions

This section describes the major features and functions of the iLink PRO software and the Twister II software. Anyone who uses the Twister II system should be familiar with the terminology in this section. This section includes some information that is only required for system integrators.

This section contains the following information:

• “iLink PRO Terminology for System Operators” (below)
• “iLink PRO Terminology for System Integrators” on page 24
• “Robot Software Terminology” on page 32
• “Positions” on page 32
• “Software Architecture” on page 36

iLink PRO Terminology for System Operators

All operators of the iLink PRO system should be familiar with the following terminology used in the iLink PRO software. System Integrators may need a more detailed description of a concept. Terminology for system Integrators is located on page 24.

Instrument Control Program (ICP)

The Instrument Control Program (ICP) is the instrument software that controls each instrument in the system; for example, reader software or Sciclone software. Some simple instruments may be controlled by a keypad or buttons on the instrument and may not have an ICP.

Instrument Method

An Instrument Method is a series of instructions that is created and saved in the Instrument Control Program (ICP) or using the instrument’s control panel. The instrument method controls the actions of the instrument during an iLink PRO method. The ability to use instrument methods is dependant on the instrument and the instrument software. To add an instruction that runs an instrument method, see “Adding Resource Operations to the Method” on page 93.
iLink PRO Method

An iLink PRO Method is a series of instructions that you run in the iLink PRO software. The system integrator creates the method and specifies the layout of materials in the system, the actions of the instruments, and the path of each plate through the system. The method also contains the default variable and parameter values, and the data configuration. Each method must be scheduled or sequenced in the Method Editor before you can run the method in the Run Method window.

To run a method, see “Running a Method” on page 131.

To create a method, see “Developing Methods” on page 76.

iLink PRO Method Set

An iLink PRO Method Set is a chain of methods that you run in the iLink PRO software. A method set enables you to run a sequence of methods automatically, in a specified order, without having to start each method individually. The system integrator creates the method sets.

To run a method set, see “Running a Method” on page 131.

To create a method set, see “Developing Method Sets” on page 126.

Parameters

Parameters enable the system operator to choose the desired value for a variable in the iLink PRO Run Method window; for example, the name of the instrument method to run. The parameters that you can choose and the values that are listed for each parameter are set up by the system integrator. Additional information for system integrators is provided in “Parameters” on page 27.

Variables

Variables are used in an iLink PRO method to supply values for instrument operations. The values of variables are not chosen by the system operator and are not displayed in the Run Method window. Additional information for system integrators is provided in “Variables” on page 27.
Materials

Materials are the plates, tip boxes, and lids that you need to load into the system to run the method. The Material Name is set by the system integrator and should enable you to correctly identify the materials. The Material Type tells you the type of plate, tip box, or lid to use. Additional information for system integrators is provided in “Material Definitions” on page 28.

Alarms

**Alarms** notify the operator if an error occurs while running a method or method set. If an alarm occurs, the alarm window opens and the system pauses execution until the operator chooses how to resolve the error. The following Error Recovery options are provided:

- You can fix the cause of the error and then choose **Retry** to repeat the instruction that failed.
- You can choose **Skip** to skip the current instruction and continue with the next instruction.
- You can choose **Finish** to finish executing the current run in the current method (not the entire method set if a method set is executing). No new runs will begin executing.
- You can choose **Stop** to stop the execution. Any instructions or moves that are in progress will complete, but no new instructions will begin executing.

To recover from an error, see “Recovering From an Error” on page 164.

Notifications

The iLink PRO Notification options enable you to automatically send an email, dial a phone number on the computer’s modem, and/or run a program if an alarm occurs while a method or method set is running. This enables iLink PRO to automatically notify someone remotely if an alarm occurs. Notifications can also be used to run a program if an alarm occurs. You use the Options window to set up the notifications (see page 121).
Remote and Standalone Modes

The ICPs for the instruments in the system can operate in either Standalone mode or Remote mode. The ICP is in **Standalone** mode if it is opened manually from the Start menu or the desktop. The ICP is in **Remote** mode if it is opened by automation control software such as iLink PRO.

Some operations with the ICP may require that the ICP is in Standalone mode, such as creating instrument methods or teaching certain positions. See the instrument's Integrator’s Guide on the Caliper Integration Kit CD or the ICP’s User’s Manual for more information.

iLink PRO Terminology for System Integrators

This section describes the features of the iLink PRO software that the system **Integrators** must be familiar with to successfully integrate instruments into the iLink PRO system. The terminology definitions in this section include details that are important for system integrators.

**Operators** of the system do not need to know all of the comprehensive information in this section. Operators should see “iLink PRO Terminology for System Operators” on page 21 for descriptions of the features necessary to operate the iLink PRO system.

Adapter Software

An Adapter is the software that enables the iLink PRO software to communicate with and control the ICP. An adapter may be able to run multiple instruments of the same type in an iLink PRO system. The adapter documentation specifies whether the adapter supports multiple instances.

System Setup

The iLink PRO System Setup specifies the names and types of resources that are included in the system. The System Setup is created in the System Setup window. Only trained system integrators should change the system setup. Specifying incorrect settings could prevent the resources in the system from operating properly.
Resource Types

The resources that can be used in the iLink PRO software are grouped into Resource Types by the functions of each resource. In iLink PRO, the resources are divided into four types; Storage, Processing, Transport, and IMS.

Storage resource types are instruments that store microplates, deepwells, tip boxes, etc. and have a specified storage capacity. Storage resource types include Twister II storage racks, incubators, carousels, etc. Storage instruments do not have Operations or Moves. (Some storage resources may be defined as two resources, one storage resource and one transport resource, such as a shuttle or drawer, to move the material.)

Processing resource types are instruments that perform an operation on the plates, and must be activated by an Operation when a sample is placed into the instrument. Processing instruments include readers, washers, liquid handlers, etc. Operations specify the actions that the instrument takes and any parameters necessary.

Transport resource types are robots, shuttles, drawers, etc. used to move materials from one instrument to another. Each transport instrument must be taught the instrument positions before being used in a method.

IMS resource types are programs, functions, etc. that process data or perform a function during the method. For example: you could receive a barcode from a barcode scanner read during one instruction, use an IMS resource to modify its value, and then in a subsequent instruction, send the modified barcode to a labeler to label a daughter plate.

To add resources to the system, see “Adding the Resources” on page 41.

Operation Parameters

Some resource operations require parameters to supply information necessary to execute the instruction or to return information generated during the execution of an instruction. The adapter documentation specifies the parameters required for an operation. There are two types of parameters: In parameters and Out parameters. Some operations use Optional In or Out parameters for additional flexibility.
In parameters are used to pass an operation parameter from the iLink PRO software IN to the adapter software. The adapter software then passes the parameter to the ICP or to the IMS resource. An example of an In parameter is a barcode that is passed into the adapter as a parameter for a PrintBarcode operation. The In parameter, InBarcode, specifies the barcode to be printed.

Out parameters are used to pass information OUT of the adapter to the iLink PRO software. The adapter receives the value from the ICP or an IMS resource. An example of an Out parameter is a barcode that is read during a ReadBarcode operation. The Out parameter, OutBarcode, is returned to the iLink PRO software when the operation is complete.

Optional parameters can be In or Out parameters. The values of optional parameters can be specified, but are not required. Parameter values are supplied depending on how the operation is used in a method. The adapter documentation specifies any optional parameters.

Use iLink PRO variables or parameters defined in the method to store the values of operation parameters during execution. See “Variables” on page 27 and “Parameters” on page 27.
Variables

The iLink PRO software enables you to use variables in your method to specify the value of an operation parameter during execution or to save a value that is received from an operation during execution. The variables are defined for each method and are used only in that method. The variables are set to the default value at the start of method execution. You cannot transfer values between methods. Variables can also be used during run-time conditional execution of instructions. Variables can be either String or Numeric. Variables are denoted by Var=VariableName in iLink PRO instructions.

For example, a String variable can be created named BarcodeValue. Issuing a ReadBarcode instruction with the BarcodeValue variable and then a PrintBarcode instruction with the BarcodeValue variable reads a barcode from a plate and then prints the same barcode. The value of BarcodeValue changes each time the barcode reader reads a barcode.

To define the variables for a method, see “Defining Variables for the Method” on page 86.

Parameters

The iLink PRO software enables you to use parameters in your method to prompt the system operator to specify the value of a variable during execution. The parameters are defined for each method and are used only in that method. The parameters are set to the specified value at the start of method execution. You cannot transfer values between methods. Parameters can also be used during run-time conditional execution of instructions. Parameters can be either String or Numeric. Parameters are denoted by Var=ParameterName in iLink PRO instructions.

For example, a String parameter can be created named MyBarcodeValue. Running a method that includes a PrintBarcode instruction with the MyBarcodeValue variable will prompt the user to enter a barcode value at the start of the method and then print the barcode. The value of MyBarcodeValue is set by the user at the beginning of the method execution and then remains the same unless it is changed by instructions in the method.

To define the parameters for a method, see “Defining Parameters for the Method” on page 88.
Material Definitions

iLink PRO enables you to define the materials used in your method. Naming the materials and specifying the material type allows the iLink PRO software to track the materials during a run and aid in recovering from an alarm if an error should occur during the run. The material types available for use by iLink PRO are stored in the Caliper Consumables database. To change the materials available, see the _Caliper Consumables Database User’s Manual_.

In each iLink PRO method, you must define the materials that the transport instruments (robots, shuttles, etc.) move within the system. You do not need to define materials that the transport instruments do not move, such as a reservoir on the Sciclone deck. (All materials on the Sciclone deck MUST be defined in the Sciclone method.) The material definitions are specific to the method in which they are created. To define the materials for a method, see “Creating the Initial Material Layout” on page 79.

Conditional Execution

The iLink PRO software supports conditional execution of instructions based on the run number. This feature allows you to choose to execute an instruction every run, every Nth run, or in a range of runs. You specify conditional execution parameters when creating the method and the conditional execution parameters are used when scheduling or sequencing the method.

The **All Runs** option executes the instruction in each run, and is the default setting for all instructions.

The **Every Nth Run** option only executes the instruction every Nth run, beginning with the run number specified. This option enables you to schedule an instruction to execute at a specified interval, instead of every run. For example, you may want to move a tip box into a position every fourth run, starting with run #1, and remove the tip box from the position every fourth run, starting with run #4.

The **Run Range** option executes the instruction only during the specified runs, beginning with the run number specified as the Start Run and ending with the run number specified as the End Run.

For more information, see “Adding Resource Operations to the Method” on page 93.
Run-Time Conditional Execution

The iLink PRO software also supports run-time conditional execution of instructions based on the current value of variables or parameters whose values are set or changed during method execution. This feature allows you to specify the condition when an instruction will be executed. iLink PRO provides the following operators to compare the values of two variables: =, !=, <, >, <=, >=. The run-time conditional execution parameters are specified when the method is created.

Since the values of the variables are not known when the method is scheduled or sequenced, iLink PRO schedules or sequences the method to execute the instruction in every run. If the condition for execution is not met at run-time, the instruction is not executed. iLink PRO does not compress the time if set to Time drive mode. If Event is selected as the drive mode, the next instruction will be executed as soon as the resources required for the next instruction are available.

For more information, see “Conditionally Executing an Instruction” on page 96.

Concurrency

The Concurrency option enables you to choose whether multiple instructions can be executed at the same time (concurrently).

- If Concurrency is enabled, multiple instructions can be executed at the same time if the resources required for the instructions are available.
- If Concurrency is disabled, only one instruction can be executed at a time, even if the required resources are available. iLink PRO uses the Concurrency setting to schedule or sequence the method.

For instructions on changing the Concurrency setting, see “Choosing the Method Scheduling Options” on page 90.

Drive Mode

The Drive Mode enables you to choose which event triggers the execution of the next instruction in the method.
• If **Time** is selected for the drive mode, each instruction is executed at the scheduled time as long as the required resources are available. (If the resources are busy, the instruction will be executed as soon as possible after the resources are available and the scheduled time for the instruction has passed.)

• If **Event** is selected as the drive mode, each instruction is executed as soon as the resources required for an instruction are available.

iLink PRO uses the Drive Mode setting to schedule or sequence the method.

For instructions on changing the Drive Mode setting, see “Choosing the Method Scheduling Options” on page 90.

**Scheduling/Sequencing**

The iLink PRO software enables you to either schedule or sequence each method to create the type of method desired and then saves the scheduled or sequenced method. iLink PRO uses the schedule or sequence to execute the method.

**Scheduling** - optimizes the use of the resources, interleaving runs as much as possible to complete the run in the shortest possible time while complying with the time constraints (Instruction Duration times and the Time Before Being Picked) set in the method. Multiple runs can be executing at the same time.

**Sequencing** - executes one entire run of a method after the previous run completes, without interleaving the runs. One run finishes execution before the next run begins. Only one run is executing at a time.

For instructions on scheduling or sequencing a method, see “Saving a Method” on page 108.

**Restacking**

iLink PRO can use the Twister II robot to restack the materials after a method, if desired. Restacking returns processed materials to their original positions in the racks, once a method is complete.

To write a restack method, set up the method with the materials in the positions they will be located in at the end of the previous method. Then create the method to move the materials from the current position back to the original positions. Create a method set that runs the original method and then runs the restack method. See “Developing Method Sets” on page 126.
All plates and lids can be restacked. Disposable Tips and empty nested tip carriers cannot be restacked and must remain in their final position in the racks.

**Lids**

The iLink PRO system accommodates materials with lids. You use the robot to remove the lid from the material and place the lid in the Lid Parking Station while the plate is processed. Then the robot can place the lid back onto the material after processing is complete.

When creating an iLink PRO method with a material that uses lids:
- Define the material (plate) as usual, selecting the material type in the Initial Layout window.
- Define the lid in the Initial Layout window with the desired material name, **Type = Lid** and the correct initial location.

Create the method in the Method Editor so that:
- The lid is removed from the plate (or stack of plates) and placed onto a lid parking station.
- The plate is picked up and placed in the desired location for processing.
- The plate is processed through the system.
- The plate is placed into the storage instrument.
- The lid is placed onto the plate.

A Lid Parking Station resource can be created in the System Setup using the SimFixedStorage adapter. If there is only one position in the lid parking station, only one lidded plate can be processed at a time.

**Instrument .ini Files**

Many instruments in the iLink PRO system use .ini files to link the ICP with the adapter software. Read the instrument’s integration guide carefully for instructions on setting up the instrument software to work with iLink PRO. Frequently, the instrument’s INI file needs to be renamed so that the name of the INI file exactly matches the name of the instrument in the iLink PRO software.
Example: If a reader is going to be named “Reader1” in the iLink PRO system setup, you should follow the instructions in the reader’s Integration Guide to create a new reader INI file named Reader1.ini. Set up the reader, such as setting the com port number, model number, etc. and then save the INI file. After the INI file is created and the instrument settings are correct, add the instrument to the iLink PRO System Setup.

Robot Software Terminology

This section defines the Robot software terminology that the iLink PRO system operators and integrators must know to operate the iLink PRO and Twister II software. System Operators should be familiar with the definitions of positions and paths if they will be re-teaching the Twister II robot positions. System Integrators must be familiar with all of the definitions provided in this section.

If you are using a robot other than the Twister II in the system, see the robot’s user documentation for details about the robot software.

Positions

A position is a saved point in space, consisting of one value for each robot axis. When the robot moves to a position, all the axes move to the points in space saved for the position. Positions are created using the Teach Wizards or the Twister II Robot software controls. Positions are saved in the Position file (pos) in the Robot\ICP\ folder.

The iLink PRO software uses positions to successfully move materials into and out of each instrument in the system. Each instrument in the system has one position with each of the names shown in the table below. If an instrument contains more than one material position, there is one of each position name for each material position. The Teach wizard automatically creates each position when you follow the instructions in the wizard.

<table>
<thead>
<tr>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick</td>
<td>Where the robot moves to retrieve a material from an instrument. May or may not be the same as the Place position.</td>
</tr>
<tr>
<td>Place</td>
<td>Where the robot moves to place a material into an instrument. May or may not be the same as the Pick position.</td>
</tr>
</tbody>
</table>
Position Types

An **Absolute** position is a single robot position, relative to the robot’s Home position. Saving an Absolute position saves the current position of all five axes. The position is saved in the Absolute folder in the Position (.pos) file. Absolute positioning should be used only by advanced users. Most users only need to use the Teach Wizards in the Twister II robot software to create the required positions and paths. The positions created by the Teach wizard are all Absolute positions.

A **Relative** position is the difference between the current position and the last Absolute position reached as a move. Relative positions are used to change the position of the robot a set number of steps, for each axis, relative to the last Absolute position reached. This position is saved in the Relative folder in the Position (.pos) file. Relative positioning should be used only by advanced users. Most users only need to use the Teach Wizards in the Twister II robot software to create the required positions and paths.

### Name | Definition
--- | ---
PickClearance | Directly above the Pick position. The robot moves down a small vertical distance *directly* to the Pick position. When the robot is holding a material in the PickClearance position, the bottom of the material must be clear of the device’s plate locator guides, and must not interfere with the device’s operation. May or may not be the same position as PlaceClearance.
PlaceClearance | Directly above the Place position. The robot moves down a small vertical distance *directly* to a Place position. When the robot is holding a material in the PlaceClearance position, the bottom of the material must be clear of the device’s plate locator guides, and must not interfere with the device’s operation. May or may not be the same position as PickClearance.
Safe | Position to which the robot moves after picking or placing a material. Always a point where the robot can rotate without contacting any device.
Paths

A path is a sequence of positions used to move the robot into or out of an instrument in the system. The Teach wizard automatically creates the required paths when you follow the instructions in the wizard. These paths are created if you choose No when the wizard asks if the robot is clear to move straight up out of the instrument.

The **Approach Path** is executed when the robot is moving from the Safe position into the instrument.

The **Clear Path** is executed when the robot is moving from the PickClearance or PlaceClearance position out of the instrument to the Safe position.

Robot Procedures

A Robot Procedure is a group of Visual Basic macros that control the movement of the robot. Macros group multiple positions and actions together in a sequence. The Teach wizards create the required macros. The system integrator can create their own procedures using the VBA editor (accessible from the main window) but must have appropriate VBA instruction before creating macros or procedures. This manual is not intended to substitute for VBA training.

Procedures (and the associated positions and paths), are saved in procedure files, which have an `.xpd` file extension. The Robot software enables you to use multiple `.xpd` files in one system. For more information on robot files, see “Robot Files” on page 35.
Robot Files

The Robot software uses .ini files to store the robot settings and to locate the proper .pos and .xpd files to use when operating the robot. When you open an .ini file in the Robot software, the main window displays the positions and paths in the .xpd and .pos files with the same names as the .ini file. The association of the .ini files with the .xpd and .pos files enables you to use multiple robots in the same system.

The following table describes the types of robot files and the contents of each file:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>File Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>.xpd</td>
<td>Stores application information.</td>
</tr>
<tr>
<td>.pos</td>
<td>Stores position information.</td>
</tr>
<tr>
<td>.ini</td>
<td>Stores robot operation information, including which .xpd and .pos files to use.</td>
</tr>
</tbody>
</table>

Robot.ini File

When you open the Robot software in **Standalone mode**, the main window displays the settings in the default .ini file named TwisterII.ini, and uses the data in the TwisterII.xpd and TwisterII.pos files. After opening the Robot software, you can open a different INI file which uses the data in the .xpd and .pos files with the same name as the INI file.

When the Robot software is started in **Remote mode** by iLink PRO, the iLink PRO software automatically opens the INI file with the same name as the robot resource (in the iLink PRO software) to control the robot.

Each robot in the iLink PRO system must have an INI file with a unique name that matches the name of the robot in the iLink PRO software. This ensures that each robot uses different XPD and POS files and communicates on a different comm port.

Two default INI files are installed with the Robot software: TwisterII.ini and XPRobot.ini. The TwisterII.ini file contains default parameters to operate the Twister II robot. The XPRobot.ini file contains parameters to operate the XP robot. You can use the default INI files as a template to create multiple robot resources with different names, as described below.
**Example:** If a Twister II robot resource will be named “Robot” in the iLink PRO system setup, you must create an INI file named Robot.ini before you add the robot to the iLink PRO software. To create the robot.ini file, open the Robot software, open the TwisterII.ini file, and save a copy of the file with the name Robot.ini in the ZyRobot\ICP\ folder. Then perform any other setup procedures, such as setting the com port number and the axis limits, in the Robot software with the correct INI file open. After the robot INI file is created, you can add the robot to the iLink PRO system setup.

Any changes necessary to the parameters in the INI file should be made in the Robot software main window. Do not manually edit the INI file, unless specified in the instructions in this manual.

**Remote and Standalone Modes**

The Robot software can operate in either Standalone mode or Remote mode.

- The Robot software is in **Standalone mode** if it is opened manually from the Start menu or the desktop.
- The Robot software is in **Remote mode** if it is opened by automation control software such as iLink PRO.

The Robot software must be in Remote mode when the robot is controlled by the iLink PRO software.

**Software Architecture**

The following software is used in addition to the iLink PRO software to execute the method or method set:

- Adapter software for each resource, which translates commands between iLink PRO and the ICP, and is invisible to the user.
- An Instrument Control Program (ICP) for each instrument, which sends the instrument-specific commands to the instrument and operates the instrument manually without running iLink PRO.

During the execution of a method, the iLink PRO software sends instructions to the adapter software. The adapter software translates the instructions and sends them to the ICP. The ICP generates and sends instrument-specific commands to the instrument for execution. When the instrument completes the command, the instrument sends a status message through the ICP and adapter software up to iLink PRO.
Figure 1 shows the communication between iLink PRO, the adapters, the ICPs, and the instruments in a system.
Integrating the System

Overview

This section of the manual describes how to set up the system and define the instruments in the system. The system setup is created by the integrator.

If the system has already been set up and you need to create a new method, see “Developing Methods” on page 76. To create a method set that contains multiple methods, see “Developing Method Sets” on page 126. To run a method or method set, see “Running a Method” on page 131.

After installing all of the required system components (the iLink PRO software, the ICPs, the adapters, and the hardware), the integrator sets up the system in the Method Editor. The system setup defines the physical resources (instruments) and the data processing resources in the system. The functions and actions the resources are programmed to perform are defined by the adapter for each resource. The adapter information is detected automatically if the adapter is a Caliper Plug and Play adapter. Only trained system integrators should modify the system setup.

The required ICP and adapter for each resource must be properly installed and configured, and the appropriately-named .ini files must be created for each instrument in the system before you can set up the system. See the instrument's Integration Guide for instructions on installing the ICP and adapter and creating a new ini file.

Setting up the system requires the following steps:

• Opening the System Setup window (see page 39)
• Adding the Resources (see page 41)
• Saving the System Setup (see page 45)
• Running an Instrument on a Remote Computer (see page 46)

Each procedure is detailed in this section.

NOTE

The integrator must make sure all the instrument positions have been created in the robot software. If the positions do not exist, the method will fail at run-time, which may cause loss of samples and/or reagent.
Opening the System Setup Window

Use the System Setup window to define the resources in the system. Resources include instruments and data-processing software applications. The operations available for each resource are determined by the adapter that the resource uses.

To open the System Setup window:

1. Start the iLink PRO software.
   - On the Windows task bar, select `Start → Programs → Caliper → iLink PRO → iLink PRO`
   - OR
   - Double-click the `iLink PRO` icon on the desktop.

   The iLink PRO software starts and displays the Startup window as shown in Figure 2.

2. On the Startup window, click the `Edit Method` button. The Method Editor window opens as shown in Figure 3 on page 40.
Opening the System Setup Window (Continued)

3 If a method is open in the Method Editor window, select File→Close to close the method.

4 Select Tools→System Setup in the Method Editor window. The System Setup window displays as shown in Figure 4 on page 40. The adapters available to iLink PRO are displayed in the Instruments list on the left side of the window.

5 To add a new instrument or software resource to the system, see “Adding the Resources” on page 41.
Adding the Resources

The resources define the instruments and/or software data-processing applications that are used in the system. If there is more than one of the same instrument in the same system, you create one resource for each instrument. For example, if there are two of the same readers in the system, you use the same reader adapter to define two reader resources with different names, both using the same Product Name. Some adapters do not allow more than one resource in the system. See the adapter documentation for details on setting up and using multiple instances. Usually these resources require two different INI files with names corresponding to the resource names in iLink PRO.

The resource kit software for each resource must be installed on the computer before you can add the resource. The following resources are installed with iLink PRO:

- Caliper SimReader
- Caliper iLink PRO Storage
- Caliper Robot
- Caliper iLink Utilities
- Caliper Simulation Adapters
- Excel DirectLink

You can use a remote computer to control any of the resources. The remote computer must be connected to the local computer over a network and the adapter software for the resource must be installed on both the local computer and the remote computer. See “Running an Instrument on a Remote Computer” on page 46 for information on configuring the DCOM settings.

To add a resource to the system:

1. On the left side of the System Setup window, click on the instrument icon (see Figure 5 on page 42) for the instrument you want to add to the system. Some instruments, such as the Twister II robot and the Sciclone have two icons, one Enhanced adapter and one generic adapter. The Enhanced adapters create a customized graphic of the instrument that matches the instrument. The generic adapters create a generic picture of the instrument with standard plate locators. Use the Enhanced adapters when available.
Adding the Resources (Continued)

2 The Instrument Name window opens as shown in Figure 6.

3 Type the desired name for the resource in the Name text box. The name can contain only upper or lower case letters and numbers and for many instruments must match the name of the instrument's .ini file. Each instrument or software instance must have a unique name. Spaces and special characters are not accepted.

- **For the Twister II robot**, use the same name as the robot's INI file.
- **For the Twister II racks**, use any name that will identify the racks, such as TwisterIIStorage.
- **For the SimReader**, use the same name as the simreader's INI file. A default SimReader.ini file is installed with the SimReader.
- **For the Notification Utility, Excel DirectLink, and Simulation Adapters**, use any name.

4 Click the OK button. A graphic of the instrument is added in the top left corner of the system layout as shown in Figure 7.
Adding the Resources (Continued)

5 Drag and drop the instrument graphic to the approximate location in the system. (The locations do not have to be exact, but it should be close to the actual location.)

6 Click on the name of the resource in the Resources list at the top right side of the System Setup window and click the Update button.

7 Click the Settings tab. The Resource Name, Product Name, Capacity (only for storage or processing instruments), and Host Machine are displayed as shown in Figure 8.

Figure 7. TIIRobot added to System Setup

Figure 8. Settings Tab
Adding the Resources (Continued)

8 If the resource is a **Storage or Processing** resource, specify the **Capacity** of the instrument. The capacity is the maximum number of runs that can be executed when the instrument is full of materials. See the instrument’s Integration Guide for more information.

9 If the resource is controlled by a remote computer, type the exact name of the computer in the **Host Computer** text box.

**NOTE**

> *When using a remote computer, see “Running an Instrument on a Remote Computer” on page 46 for instructions on setting up the remote computer as a Host for the instrument software.*

10 Click on the **Properties** tab. Figure 9 shows the Properties tab for a Processing resource.

![Figure 9. Properties Tab](image)

11 If desired, click the **Select Icon** button to choose a different icon for the resource. You may want different icons if you have more than one of the same instrument in the system. Navigate to C:\Program Files\CaliperLS\iLinkPro\Icons\32x32. Click on the desired icon and click the **OK** button.
Adding the Resources (Continued)

12 If the resource is a Processing resource:
   a. Select the number of plate locations that you want to show in the Number of Plate Locations text box.
   b. In the Number of Rows text box, select the number of rows of plate locations the instrument uses. Rows of materials go from left to right.
   c. In the Number of Columns text box, select the number of columns of plate locations the instrument uses. Columns of materials go from back to front.

13 If the resource is the Twister II Storage Racks, select the number of pods that are installed.

14 If the resource is a SimStorage resource:
   a. Select the number of plate locations you want initially displayed in the Minimum Number Of Plate Locations text box.
   b. If Fixed Number of Plate Locations is not selected, the number of plate locators will increase as new materials are placed into the resource. If selected, the number of locators is fixed and only a fixed number of materials can be placed into the resource.

15 Click the OK button to save the instrument properties.

16 Continue adding the resources until all the resources have been added to the system. When the system setup is complete, see “Saving the System Setup” on page 45.

Saving the System Setup

Changes to the system setup are saved as the changes are made in the System Setup window. When you are done creating or editing the system setup, click the Save and Close button at the bottom of the System Setup window to close the window and display the Method Editor window. The Method Editor window displays all of the resources in the system in the Initial Layout window of all methods.

When the system setup is complete, the integrator can create the methods for the system. See “Developing Methods” on page 76.
Running an Instrument on a Remote Computer

This section explains how to run an instrument in an iLink PRO system on a remote computer.

iLink PRO uses DCOM to operate the instrument and control the instrument software. Changes to the default DCOM settings must be made on both computers to enable communication.

NOTE

These changes disable many security settings on both the local and remote computers. Contact your company’s IT department for your policies on required security settings.

Requirements:

• Both computers must be connected to a network and be able to browse to each other in Network Neighborhood.
• The LOCAL computer is the computer where iLink PRO is installed and running.
• The REMOTE computer is the computer where the remote instrument software is running.

To enable iLink PRO to run an instrument installed on another computer:

1 Install iLink PRO and the instrument Resource kits (adapter and ICP) on the LOCAL computer.

2 To determine the name of the REMOTE computer, right-click on My Computer and select Properties. Click the Computer Name tab. Figure 10 on page 47 shows a computer named 1288-A.caliperls.net.
Running an Instrument on a Remote Computer (Continued)

3 Close the System Properties window.

4 Install the instrument Resource kits (adapter and ICP) on the REMOTE computer (the computer that will run the instrument).

**NOTE**

*The versions of the adapter and ICP on both computers must be exactly the same versions and all software must be installed with access for All Users (not the Only Me option).*

5 On the **both the LOCAL and REMOTE computers**, perform the following steps to set up the computer to allow iLink PRO to control the software:

6 On the Windows Start menu, select **Start→Control Panel**. If necessary, click **Switch to Classic View** to see all icons.

7 Double-click **Administrative Tools**.
Running an Instrument on a Remote Computer (Continued)

8  Double-click **Component Services**. The Component Services window opens as shown in Figure 11 on page 48.

9  Double-click the **Component Services** icon in the right pane.

10 Double-click **Computers** in the right pane.

11 Right-click **My Computer** and select **Properties** from the shortcut menu as shown in Figure 11. The My Computer Properties window opens.

![Figure 11. Component Services Window](image)
Running an Instrument on a Remote Computer (Continued)

12 Click the **Default Properties** tab as shown in Figure 12.

![Figure 12. Default Properties Tab](image)

13 Select the following settings:

a. Select Enable Distributed COM on this computer.

b. Clear Enable COM Internet Services on this computer.

c. Default Authentication Level: **(None)**

d. Default Impersonation Level: **Identify**
Running an Instrument on a Remote Computer (Continued)

14 Click the **COM Security** tab as shown in Figure 13.

![Figure 13. Com Security Tab](image)

15 Under **Access Permissions**, click the **Edit Default** button.

16 Click the **Add** button.

17 Click the **Advanced** button.

18 Click the **Find Now** button.

19 Select the entry in the list with the name **EVERYONE**. (Don't select the entire list, just the entry that says Everyone.)

![Figure 14. Everyone Group](image)

20 Click the **OK** button to add the **Everyone** group to the text box.

21 Click **OK**.

22 Click **OK** on the Access Permissions window.
23 Under **Launch Permissions and Activations**, click the **Edit Default** button.

24 Click the **Add** button.

25 Click the **Advanced** button.

26 Click the **Find Now** button.

27 Select the entry in the list with the name EVERYONE. (Don’t select the entire list, just the one that says Everyone.)

![Figure 15. Everyone Group](image)

28 Click the **OK** button to add the **Everyone** group to the text box.

29 Click **OK**.

30 Click **OK** on the Launch Permissions and Activations window.

31 Click **OK** on the My Computer Properties window.

32 Leave the Component Services window open and continue with the next section.

**Set Up DCOM for the Instrument Software**

Perform these steps on both the LOCAL and REMOTE computers:

1. With the Component Services window still open, double-click on **My Computer** in the right pane.

2. Double-click **DCOM Config** in the right pane. A list of all components that can be configured to use DCOM displays in the right pane as shown **Figure 16 on page 52**.
For each of the software components that you are running remotely (see the list on page 53):

a Right-click on the component name and select Properties.

b Select the Identity tab and choose The Interactive User.

c Click the Apply button.

d Click the OK button.
Caliper Component Names

The components for **some of the Caliper Resource kits** are listed below:

**Robot and Racks**
- iLinkStorage.cServer
- ZyRobotAdapter.Cserver
- ZyRobotICP.cPath

**iLink PRO Adapters**
- CaliperLSExcelServer.ExcelServer
- ConsumablesDB.clsConsumable
- NotificationUtility.clsClientInterface
- SimFixedStorageAdapter.Cserver
- SimProcessAdapter.CServer
- SimRandomStorageAdapter.Cserver
- SimReaderAdapter.CServer
- SimReaderICP.clsClientInterface
- SimTransportAdapter.CServer
- ZyMSExcellMSAAdapter.CServer
- ZyNotificationAdapter.CServer

**LJL Reader**
- LJLICP.clsLJLServer
- ZyLJLReaderAdapter.CServer

**Sciclone**
- CavroDeviceController
- CommDispatcher.CTrace
- MotionPlanner
- nanoDispSrv
- ScicloneICP.CControlInstructions
- ScicloneICP.CEditParameterGUI
- SciPEM
- SciRabbitVexta
- TaskManager
- ZyScicloneALH3000Adapter.CServer

**Others (Wrapper DCC, etc.)**
- ZyEMBLAAdapter.CServer
- ZyKeyenceBL600Adapter.CServer
Integrating the System

P/N 112580 Rev. 0 iLink PRO User’s Manual Caliper Life Sciences, Inc.

- ZyKeyenceBL600ICP.clsKeyenceBL600
- ZymarkIncubator.clsZyIncubatorServer
- ZymarkIncubatorAdapter.CServer
- ZyVSpinAdapter.Cserver
- ZyVSpinICP.clsVSpinICP

4 Close the Component services window and all other open windows.

5 Repeat for the other computer.

Turn Off Windows Firewall on BOTH Computers

Perform these steps on both the LOCAL and REMOTE computers:

1 Choose Start→Settings→Control Panel.
2 Double-click Windows Firewall.
3 Select the OFF option button.

Create a new Registry Key on the Remote Computer

NOTE

These instructions are only for experienced integrators with the proper training. Incorrect entries in the Registry can cause serious problems that may require you to reinstall your operating system. Edit the Registry at your own risk.

1 Open the Registry Editor and go to HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\WindowsNT\RPC
2 Create a DWORD value named Restrict Remote Clients and leave the default value unchanged (0).
3 Click Start→Run and type gpedit.msc. The Group Policy Console opens.
5 In the right pane, double-click DCOM: Machine access restrictions...
6 Select Enable Policy.
Create a new Registry Key on the Remote Computer (Continued)

7 Click Edit Security.
8 Give Full Permissions to all users listed.
9 You may need to right-click and select Reload.
10 Repeat for DCOM: Machine Launch restrictions…
11 Right-click on Security Options and choose Reload.
12 Close the Console.
13 You may need to reboot.

Registering AdapterInterface22.tlb

The AdapterInterface22.tlb must be present and registered on the HOST (remote) machine. It can be located in any directory, but must be registered.

Set up More Lenient Security Policy on BOTH Computers

1 Choose Start→Administrative Tools→Local Security Policy.
2 Right-click on Security Settings in the left pane and choose Import Policy.
3 Choose COMPATWS and click the Open button.
4 Right-click on Security Settings in the left pane and choose Reload.

Turn Off Simple File Sharing on BOTH Computers

1 Choose Start→Programs→Accessories→Windows Explorer.
2 Select Tools→Folder Options.
3 Click the View tab.
4 Uncheck Use Simple File Sharing (Recommended).
Adding the Remote Resource to iLink PRO

1. On the LOCAL computer, start iLink PRO.
2. Go to the System Setup window.
3. Add the resource as usual.
4. Select the resource name in the list and click the **Update** button.
5. In the **Host** text box, type the name of the remote computer (see page 46).
6. Click the **OK** button to save the changes.
Teaching the Robot

Overview

This section describes how to teach robot positions for the Twister II Storage racks (see below), and the instruments in the system (see page 64). The robot and the instruments must be installed in their permanent locations, and you must know the names of the iLink PRO instruments before teaching the robot.

Teaching the Twister II Storage Racks

You can teach the storage racks with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by the iLink PRO software).

To teach the Twister II storage racks:

1. If the iLink PRO software is running, the Robot software is already started. Otherwise, start the Robot software from the Windows Start menu.

2. On the Windows task bar, click the Twister II Robot ICP button to show the Robot software main window.

3. If the Robot software is in Remote mode, the INI file with the same name as the robot resource opens automatically.

If the Robot software is in Standalone mode, open the INI file with the same name as the robot that you are teaching, click the Initialize button to initialize the robot, and click the Home All Axes button to Home the robot before teaching.
Teaching the Twister II Storage Racks (Continued)

4  Click the **Teach tab** on the Robot software main window.

![Figure 19. Robot Teach Tab](image)

5  Click the **Add** button below the Names list.

6  Type the name of the Twister II storage racks in the **Instrument Name window** and click the **OK** button. The Select Teaching Wizard window displays as shown in **Figure 20**.

![Figure 20. Select Teaching Wizard Window](image)
Teaching the Twister II Storage Racks (Continued)

7 To teach the Twister II storage racks, click the Yes option and click the OK button. The Rack Teach Wizard Welcome Window displays as shown in Figure 21.

8 Follow the instructions on the Welcome window and then click the Next button. The Step 1 window displays as shown in Figure 22.

9 If desired, adjust the speed that the robot will move at when moving to and from the racks.

10 Click the Next button to display the Rack Teach Wizard - Step 2 window as shown in Figure 23.
Teaching the Twister II Storage Racks (Continued)

11 Select the check boxes next to the numbers of the racks in the system. You must teach all of the racks in the system. You cannot teach only some of the racks. Rack 1 is always selected.

12 Click the Next button on the Step 2 window. The Step 3 window displays as shown in Figure 24.
Teaching the Twister II Storage Racks (Continued)

13 Follow the instructions on the Step 3 window:
   a Place the teach plate (included with the Twister II) on the top of rack 1. Be sure the teach plate rests flat on the top of the rack.
   b Support the Twister II arm.

WARNING

You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.

14 Click the Next button. The robot motors release (so that you can move the robot arm manually) and the Step 4 window displays as shown in Figure 25. Do not let the arm drop.

15 Move the robot arm to place the gripper onto the teach plate on rack 1. Make sure the gripper is centered front-to-back and side-to-side. Lift and lower the arm once or twice to ensure the arm is positioned correctly. Then remove your hands from the arm and teach plate.
Teaching the Twister II Storage Racks (Continued)

**WARNING**

⚠️ WARNING ⚠️

*Make sure hands and fingers are away from the robot before performing the next step.*

16 Click the **Next** button to teach the position. The robot grippers close on the teach plate. If you are teaching more than one rack, the Step 5 window (shown in Figure 26) displays instructions to teach the next rack.

![Figure 26. Rack Teach Wizard - Step 5](image)

17 With the robot grippers still holding the teach plate, move the robot arm to the next rack and fit the teach plate into the top of the rack. (Move the arm by lifting the arm from underneath, not by the wrist or grip.) Make sure the teach plate fits flat on the top of the rack and is centered on the rack. Lifting and lowering the arm once or twice will ensure the arm is positioned properly.

18 Repeat steps 16 and 17 until all of the rack positions have been taught. When you click the **Next** button after teaching the last rack, the Teaching Complete window displays (see Figure 27 on page 63).
Teaching the Twister II Storage Racks (Continued)

19 Click the Finish button. The Save Changes window displays as shown in Figure 28.

20 Click the Yes button to save the positions. The Rack Teach Wizard closes and the Robot software main window displays.

21 To permanently save changes, select File→Save to save the robot project.
Teaching the Instrument Positions

You can teach the instrument positions with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by the iLink PRO software).

To teach an instrument position:

1. If the iLink PRO software is running, the Robot software is already started. Otherwise, start the Robot software from the Windows Start menu.

2. On the Windows task bar, click the Twister II Robot ICP button to show the Robot software main window.

3. If the Robot software is in Remote mode, the INI file with the same name as the robot resource opens automatically.

   If the Robot software is in Standalone mode, open the INI file with the same name as the robot that you are teaching, click the Initialize button to initialize the robot, and click the Home All Axes button to Home the robot before teaching.

4. Click the Teach tab on the Robot software main window.
5 Click the **Add** button below the Names list.

6 Type the name of the instrument in the Instrument Name window and click the **OK** button. The name specified must **EXACTLY** match the name of the instrument in the iLink PRO System Setup. The Select Teaching Wizard window displays as shown in **Figure 20**.

7 To teach an instrument, click the **No** option and click the **OK** button. The Instrument Teach Wizard Welcome Window displays as shown in **Figure 32**.
Teaching the Instrument Positions (Continued)

8 Follow the instructions on the Welcome window and then click the **Next** button. The Step 1 window displays as shown in Figure 33.

9 If desired, adjust the speed that the robot will move at when moving to and from the racks.

10 Click the **Next** button to display the Instrument Teach Wizard - Step 2 window as shown in Figure 34.
11 Use the arrow buttons next to the **Number of Locations** text box to set the number of instrument locations that the robot will access. The default is 1.

12 Click the **Next** button. The Step 3 window displays as shown in Figure 35. The “Location 1 of” text on the window indicates how many instrument locations are being taught and which position you are currently teaching.

13 Use the arrow buttons next to the **Position Number** text box to set the position number of the location you are teaching. The default is 1. See “Example: Sciclone Position Numbers and Locations” on page 75 for an example where the position number does not equal the location number.
Teaching the Instrument Positions (Continued)

14 Click the Next button. The Step 4 window displays as shown in Figure 36.

![Instrument Teach Wizard - Step 4 Window](image)

**Figure 36. Instrument Teach Wizard - Step 4 Window**

15 Place an empty microplate in the plate location shown in the Step 4 window. Make sure the plate is flat, flush and as centered as possible.

16 Hold the Twister II arm so it does not drop.

**WARNING**

*You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.*

17 Click the Next button. The robot servo motors release so you can move the robot arm manually. If you don't hold the robot arm, it will drop. The Step 5 window displays as shown in Figure 37 on page 69.
Teaching the Instrument Positions (Continued)

18 Move the robot arm to the instrument and center the grips over the microplate. Make sure the grip assembly is centered over the microplate and rests flat on the microplate.

19 Click the **Next** button to teach the position to the robot. The robot grippers close on the microplate and the Step 6 window displays as shown in Figure 38.
Teaching the Instrument Positions (Continued)

20 Following the instructions on the window, lift up the robot arm (still holding the microplate), place the tallest material that will be used in the system into the instrument, and then place the microplate (still in the robot grippers) on top of the tallest material. Make sure the microplate is centered over the material and rests flat on the material.

21 Click the **Next** button to teach the position. The Step 7 window displays as shown in Figure 39.

![Figure 39. Instrument Teach Wizard - Step 7 Window](image)

22 If the instrument returns the material in a slightly different position than originally placed, select the **Yes** option to teach a different Pick location for the instrument. If the material is in exactly the same position after it is processed, select the **No** option.

23 If you selected **Yes**, do not click the Next button. Continue with step 24 below.

   If you selected **No**, click the **Next** button and go to step 27.

24 Hold the Twister II arm so it does not drop.

**WARNING**

You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.
Teaching the Instrument Positions (Continued)

25 Click the Next button. The robot servo motors are released so you can move the robot manually. Hold the robot arm so it does not drop. The Step 8 window displays as shown in Figure 40.

![Figure 40: Instrument Teach Wizard - Step 8 Window](image)

26 Find the pick location for the material:

   a  Using the controls on the Robot software main window, and while holding the material, release the grip.

   b  Place the material into the instrument's material tray or drawer.

   c  Process the plate with the instrument to position the microplate in the position it will be in after processing.

   d  Position the robot grips over the microplate. Make sure the grip is centered over the microplate and rests flat on the microplate. Be careful not to move the microplate.

   e  Using the controls on the Robot software main window, close the grips around the material.

27 Click the Next button to teach the position. The Step 9 window displays as shown in Figure 41 on page 72.
Teaching the Instrument Positions (Continued)

28 Following the instructions on the window, place the tallest material that will be used in the system in the same position as the microplate was in.

29 Position the robot grips (holding the microplate) on top of the tallest material. Make sure the microplate is centered over the material and rests flat on the material.

30 Click the **Next** button to teach the position. The Step 10 Clearance window displays as shown in Figure 42.

![Figure 41. Instrument Teach Wizard - Step 9 Window](image1)

![Figure 42. Instrument Teach Wizard - Step 10 Window](image2)
Teaching the Instrument Positions (Continued)

31 If the robot is clear to move up to its highest vertical position, you do not need to teach a clear path. Click the Next button and skip to step 33 on page 74.

If the robot is not clear to move up to its highest vertical position, continue with the next step.

32 Teach the clear path:
Use the Clearance window to teach the path out of the instrument if the robot cannot move directly up to its vertical limit when leaving the material location. The clear path is made up of multiple positions. The robot will move in a direct line from one position to the next. For obstructions directly above the arm, you will usually teach a position to the left or right, and then any additional positions as necessary to clear the vertical obstruction.

WARNING

You must support the robot arm before performing the next step! When the robot motors are released, the arm will drop if not supported.

a Hold the Twister II arm so it does not drop.

b Click the Disable button to release the robot servo motors so you can move the robot to the desired position. Make sure the robot can reach the next position by moving in a direct line from any material position in the instrument.

c Move the robot to the desired position and click the Teach button. The robot servo motors engage when you click the Teach button.

d Repeat steps a through c until the robot arm has a clear path up to the vertical limit.
Teaching the Instrument Positions (Continued)

33 Click the **Next** button on the Clearance window. If the instrument has more than one position, go to step 15 on page 68 and repeat the teaching instructions for each position in the instrument. When all of the material positions for the instrument have been taught, the Teaching Complete window displays as shown in **Figure 43**.

![Figure 43. Instrument Teach Wizard - Teaching Complete](image)

34 Click the **Finish** button. The Save Changes window displays as shown in **Figure 44**.

![Figure 44. Save Changes window](image)

35 Click the **Yes** button to save the positions. The Instrument Teach Wizard closes and the Robot software main window displays.

36 To permanently save changes, select **File** → **Save** to save the robot project.
Example: Sciclone Position Numbers and Locations

The Caliper Sciclone ALH 3000 has 20 plate locations on the deck as shown in Figure 45. In iLink PRO, the positions are numbered 1 through 20, with 1 in the upper left and 20 in the lower right.

![Figure 45. Sciclone Position Numbers](image)

The Twister II Robot cannot access all positions on the Sciclone. The location of the Twister II robot determines which positions can be accessed.

As an example, if the Twister II Robot is located on the right side of the Sciclone and can reach 5 positions, when teaching the robot using the Instrument Teach wizard:

1. Set the **Number of Locations** to 5 (because that is the number of positions you will be teaching).

2. When teaching each location, change the **Position Number** to match the Sciclone Deck position number as shown above.

When you are teaching the Sciclone, Location 1 might be Position 5, Location 2 might be Position 10, Location 3 might be Position 14, Location 4 might be Position 15, and Location 5 might be Position 20. Although the positions do not need to be taught in any order, you must change the position number to match the Sciclone position you are teaching.
Developing Methods

Overview

This section describes how to create iLink PRO methods. The method contains the instructions to perform on the materials in each run. A basic method normally begins by removing a material from a storage location such as the Twister II racks. The sample is processed using the instruments in the system, then returned to an empty Twister II rack or discarded to a waste location.

When the method is saved, you must schedule or sequence the method. iLink PRO creates an optimized schedule for the method using the specified parameters and saves the schedule or sequenced method.

After the methods have been created, the integrator can create method sets to chain methods together, if desired. See “Developing Method Sets” on page 126 for details.

To execute a method or method set, see “Running a Method” on page 131.

The following procedures are detailed in this section:

• “Creating a New Method” on page 77
• “Opening a Method” on page 105
• “Editing a Method” on page 106
• “Saving a Method” on page 108
• “Adjusting the Method” on page 117
• “Setting the iLink PRO Options” on page 118
• “Closing the Method Editor Window” on page 123
• “Importing/Exporting Methods” on page 124
• “Running Methods from the Method Editor Window” on page 124
Creating a New Method

Creating a new method involves the following steps:

- Opening a New Method (below)
- “Creating the Initial Material Layout” on page 79
- “Defining Variables for the Method” on page 86
- “Defining Parameters for the Method” on page 88
- “Choosing the Method Scheduling Options” on page 90
- “Adding Moves to the Method” on page 91
- “Adding Resource Operations to the Method” on page 93
- “Adding Resource Comments to a Method” on page 95
- “Conditionally Executing an Instruction” on page 96
- “Changing the Instruction Duration” on page 97
- “Executing an Instruction Only During Specific Runs” on page 98
- “Saving a Method” on page 108

Each of these steps is described in detail in this section.

Opening a New Method

To open a new method:

1. Start the iLink PRO software (see page 132) and click the Edit Method button on the Startup window, OR from the Run Method window, choose Tools→Switch to Editor.

2. Click the New button or choose File→New Method on the Method Editor window to open a new Method window as shown in Figure 46. The Initial Layout of Materials instruction is selected on the Method tab on the right side of the window, and a blank system layout diagram displays on the left side of the window.
Add the materials to the method (see page 79).
Creating the Initial Material Layout

When a new method opens, you must create the initial material layout, which specifies the positions of all the materials (plates, tip boxes, reservoirs, etc.) at the start of the method. Only one of each defined Material Name can be processed in a method. For example, if you are using four daughter plates in a method, each plate must have a unique Material Name, such as Daughter1, Daughter2, Daughter3, and Daughter4, even if all of the daughter plates are the same type of plates. You must create the initial layout before adding the instructions to the method. The initial layout is saved with the method and a new initial layout must be defined for each method.

To add materials to a method:

1. After opening a new method, the Initial Layout diagram displays in the Method Editor window as shown in Figure 46 on page 78.
2. Locate the desired consumable in the consumables list.
3. Click the consumable icon and drag it to a position in the system where it will be located at the beginning of the method.
4. When you drop the material onto a location, the Material Name window opens as shown in Figure 47.

![Material Name Window]

5. In the Name text box, type a name for the material. Note that when adding multiple materials to the same Twister II storage rack, the materials are sorted alphabetically, with the name closest to Z appearing at the top of the stack. To add materials correctly, you must add materials alphabetically, starting with the name closest to A.

6. Click the OK button to add the material to the Initial Layout.
Creating the Initial Material Layout (Continued)

7 If the same material is located in more than one location at the beginning of the method, click on the material in the layout diagram and drag the material to any other locations where it will be located.

Example:
To fill two Twister II racks with the same material, drag the material you defined for rack 1 to rack 2 as shown below.

![Figure 48. Multiple Locations for One Material](image)

8 If the method moves the plates to an empty Twister II rack during the method, you must define an output rack:

a Drag the material from any location in the layout diagram to the output rack.

b Drag the Make Output icon onto the output rack.

![Figure 49. Twister II Output Rack](image)

If the method discards the material to waste instead of placing it into an empty rack, you do not need to define an output rack.
Creating the Initial Material Layout (Continued)

9 If a method uses more than one material in the same Twister II rack, for example, plates with lids or 4 empty daughter plates, drag the additional plates into the racks one at a time, following steps 2 through 8 for each material.

If a method uses more than one material in the same rack, the materials must be stacked in the order in which the method uses the materials. The integrator must specify the order of multiple materials in the same rack for operators. Only the exact same plate type and part number can be in a rack, with the exception of lids.

Example: If you are placing 96 well plates into a rack, you may only place that type of plate, and its lids, into that rack. Specifically, two plates with the same specifications but from different manufacturers may not be used in the same rack. Daughter A and Daughter B plates, if they are in the same rack, must be the same plate type, from the same manufacturer, with the same part number.

10 Repeat steps 2 - 9 to add all of the materials to the method.

11 When all of the required materials have been added to the method, click the Done button. The initial layout is saved and the Consumables list closes.

To define variables, see page 86.

To define parameters, see page 88.

To choose the method execution options, see page 90.

To add moves to the method, see page 91.

To add resource operations to the method, see page 93.

To save the method, see page 108.
Example: Adding Multiple Materials to Twister II Racks

This example demonstrates how to add three plates with different names to the same Twister II rack. The plate names will be Mother, Daughter, and Destination. All three plates must be the same plate type.

The plates MUST be added in alphabetical order as follows:

1. Daughter
2. Destination
3. Mother

If the plates are not added in alphabetical order, the initial material setup will not be correct.

To add the materials:

1. Drag the desired material for Daughter to Storage Rack 1. The Material Name window opens.

   ![Material Name Window](image)

   **Figure 50. Material Name Window**

2. Type **Daughter** in the text box and click the **OK** button.

3. Drag the **Daughter** plate from rack 1 to rack 2.
Example: Adding Multiple Materials to Twister II Racks (Continued)

4  Drag the **Daughter** plate from rack 2 to rack 3.

![Drag from Rack 2 to Rack 3](image)

*Figure 51. Twister II Output Rack*

5  Drag the **Make Output** icon onto rack 3. The layout for Daughter is complete. Now you need to add the Destination plate.

![Drag and Drop to Rack 2](image)

*Figure 52. Twister II Output Rack*

6  Drag the material for **Destination** to Storage Rack 1. In this example, Destination must be the same type as Daughter. The Material Name window opens.

7  Type **Destination** in the text box and click the **OK** button.

8  Drag the **Destination** plate from rack 1 to rack 2. Notice that the colored outline around the plate in Rack 1 changes color to indicate a different material.
Example: Adding Multiple Materials to Twister II Racks
(Continued)

9 Drag the **Destination** plate from rack 2 to rack 3.

![Figure 53. Twister II Output Rack](image)

Drag from Rack 2 to Rack 3

10 Drag the **Make Output** icon onto rack 3. The layout for Destination is complete. Now you need to add the Mother plate.

![Figure 54. Twister II Output Rack](image)

11 Drag the material for Mother to Storage Rack 1. In this example, Mother must be the same type as Daughter. The Material Name window opens.

12 Type **Mother** in the text box and click the **OK** button.

13 Drag the **Mother** plate from rack 1 to rack 2.
Example: Adding Multiple Materials to Twister II Racks (Continued)

14 Drag the **Mother** plate from rack 2 to rack 3.

![Figure 55. Twister II Output Rack](image)

Drag from Rack 2 to Rack 3

15 Drag the **Make Output** icon onto rack 3. The layout for Mother is complete.

![Figure 56. Twister II Output Rack](image)

16 Click the **Done** button to finish the initial layout.
Defining Variables for the Method

Variables can be used in a method to:
- change the value of an instruction parameter during execution.
- store a value returned from the execution of an instruction.
- be evaluated during execution using the Run-Time Conditional Execution operators to determine whether to execute a particular instruction.

The variables are set to the default values at the start of method execution and cannot transfer values between methods. See “Variables” on page 27.

To add a variable to the method:

1. Click the **Locals** tab in the Method Parameters window as shown in Figure 57.

![Figure 57. Locals Tab](image)

2. Click the **Add** button. The Variable window opens as shown in Figure 58.

![Figure 58. Variables Window](image)

3. Type the desired name for the variable in the **Name** text box. Use any name that describes the variable.
Defining Variables for the Method (Continued)

4 Choose the type of data the variable holds from the **Type** drop-down list, either Numeric or String. When comparing two variable values, both variables must be the same type.

5 Type the desired default value for the variable in the **Value** text box.

6 Click the **OK** button to save the variable in the method.

7 Repeat steps 2 through 6 to add all of the variables to the method.
Defining Parameters for the Method

Parameters are variables that prompt the system operator to supply a value at the start of method execution. Parameters can be used in a method to:

- enable operators to select the value of the parameter before running the method
- change the value of an instruction parameter during execution.
- store a value returned from the execution of an instruction.
- be evaluated during execution using the Run-Time Conditional Execution operators to determine whether to execute a particular instruction.

The parameters are set to the user-specified values at the start of execution of a method and cannot transfer values between methods. See “Parameters” on page 27 for more information.

To add a parameter to the method:

1. Click the Parameters tab in the Method Parameters window as shown in Figure 59.

2. Click the Add button. The Parameter window opens as shown in Figure 60.
Defining Parameters for the Method (Continued)

3 Type the desired name for the parameter in the **Name** text box. Use any name that describes the parameter.

4 Choose the type of data the parameter holds from the **Type** drop-down list, either Numeric or String. When comparing two variable values, both variables must be the same type.

5 Type the desired **default** value for the parameter in the **Value** text box.

6 Type the desired possible values for the parameter in the **Possible Values** text box. Separate each of the possible values with a semicolon. Include the default value if you want it to be displayed in the drop-down list. (The possible values are displayed on the Setup Parameters tab in the Run Method window when a system operator opens a method or method set.)

7 Click the **OK** button to save the parameter in the method.

8 Repeat steps 2 through 7 to add all of the variables to the method.
Choosing the Method Scheduling Options

The Method Scheduling options enable you to choose how the instructions in the method will be scheduled and executed. Drive Mode options (Time or Event) enable you to choose whether time parameters are enforced. For more information on Drive Mode, see “Drive Mode” on page 29. Concurrency options enable you to choose whether instructions are executed one at a time or simultaneously. For more information on Concurrency, see “Concurrency” on page 29.

1 With the Method open, click the **Schedule Type** tab under Method Parameters. (If the Method Parameters window is not visible, select View→Method Parameters.) The Schedule Type tab is shown in Figure 61.

![Figure 61. Schedule Type Tab](image)

2 Select the desired Schedule Type: either **Schedule** or **Sequence**. For information on the differences between scheduling and sequencing, see “Scheduling/Sequencing” on page 30.

3 Select the desired **Concurrency** option: **Enable** to allow multiple instructions to be executed at the same time, or **Disable** to only execute one instruction at a time.

4 Select the desired **Drive Mode** option: **Time** - executes the method based on the time scheduled for each instruction, or **Event** - executes the method based on the availability of the resources required for each instruction. If you select Event, the Time column is not displayed in the Run Method tab on the Run Method window.

5 If you change any options on the Schedule Type tab, you must save the method to use the new settings.
Adding Moves to the Method

The Move instructions in the method specify the movements of the materials through the system. The first instruction in a method is usually a move instruction from a storage instrument into a processing instrument.

To add a move instruction to the method:

1. Locate the material that you want to move in the Layout diagram in the Method window (see Figure 64).

2. Click on the position where the material is located and drag the material to the destination position. (If there are multiple materials stacked in the same locations, see “Example: Moving a Plate from a Rack with Multiple Materials” on page 92.)

3. If the Move should only be executed based on comparing two variable values, see “Conditionally Executing an Instruction” on page 96.

4. Verify that the instruction duration time displayed in the Instruction Duration text box is correct. see “Changing the Instruction Duration” on page 97.

If there are multiple transport resources in the system, a dialog box displays a list of the transport resources. Choose the transport resource that will be used to move the material and click the OK button to add the Move instruction to the method.

If there is only one transport resource, the Choose Transport Resource window only displays once.
Adding Moves to the Method (Continued)

5 If you only want the Move to be executed during certain runs, see “Executing an Instruction Only During Specific Runs” on page 98.

6 To add an instrument instruction to the method, see “Adding Resource Operations to the Method” on page 93.

7 When the method is complete, save the method. See “Saving a Method” on page 108 for details.

Example: Moving a Plate from a Rack with Multiple Materials

To move a plate from a rack that contains multiple materials:

1 Click and drag the top material in the rack to the destination. The plate shown in the move is always the top plate in the stack (last in alphabetical order).

2 To move a plate other than the top plate, double-click on the Move instruction in the Method window to open the Edit Move Instruction window as shown in Figure 63.

![Figure 63. Edit Move Window](image)

3 Select the material that you want to move in the Material dropdown list.

4 Click the OK button. The Move instruction in the Method window is updated with the new material name.
Adding Resource Operations to the Method

The resource operation instructions in the method specify the instrument methods to run, the data processing to perform, and the timing and delays in the method. (To add a Move instruction, see “Adding Moves to the Method” on page 91).

To add instructions to the method:

1. Click the **Method** tab on the right side of the Method Editor window as shown in Figure 64.

![Figure 64. Method tab](image)

2. Locate the tab for the desired resource in the Commands list on the left side of the Method Editor window. Click the command tab to display the operations for an instrument.

3. Click and drag the desired command into the Method tab or System Layout. When the instruction is dropped into the method, the Command Parameters window for the instruction displays. Figure 65 on page 93 shows an example of a Sciclone Execute Method window.

![Figure 65. Sciclone Execute Method Window](image)
Adding Resource Operations to the Method (Continued)

To add a Delay instruction, click the Delay button on the tool bar and continue with step 5.

4 If you are adding a Processing or IMS instruction and the instruction has parameters, choose the value for each parameter:

a To supply the value of an In parameter directly from the text box, type the desired value in the text box.

b To supply the value of an In parameter using a variable or parameter defined in the method, click the Variable (V) button and choose the name of the variable or parameter from the drop-down list. If you choose a parameter, the operator can choose the desired value in the Run Method window. To add possible values for parameters, see “Defining Parameters for the Method” on page 88.

c The value that an Out parameter returns to iLink PRO must be stored in a variable. Click the Variable (V) button and choose the variable that will hold the returned value.

d If the instruction has Optional Parameters available, choose the value for the parameters that you want to use.

5 Specify any other parameters required for the instruction. These parameters vary depending on the instruction selected.

6 Click the OK button. The instruction displays in the Method tab. If an instruction is selected in the Method tab, the new instruction is added below the selected instruction. If no instruction is selected, the instruction is added at the end of the method.

7 If the instruction is not in the correct position in the method, use the Cut and Paste buttons to move the instruction to the desired position.

8 If you want to add a comment to a method to remind the system operator to do something before starting the method, see “Adding Resource Comments to a Method” on page 95.

9 If the Instruction should only be executed based on comparing two variable values, see “Conditionally Executing an Instruction” on page 96.
Adding Resource Operations to the Method (Continued)

10 Verify that the instruction duration time displayed in the Instruction Duration text box is correct. See “Changing the Instruction Duration” on page 97.

11 If you only want the instruction to be executed during certain runs, see “Executing an Instruction Only During Specific Runs” on page 98.

12 When the method is complete, save the method. See “Saving a Method” on page 108 for details.

Adding Resource Comments to a Method

Resource Comments are displayed in the Run Method window and are intended to remind the system operator of any extra steps they may need to perform for an instrument before starting the method execution. For example, if the system operator must fill reagent bottles in a liquid dispenser instrument before starting a method, the method developer can add a resource comment to the liquid dispenser that reminds the operator to fill the reagent source bottles.

To add a resource comment to a method:

1 With the method open in the Method Editor window, click the Resource Comments tab in the Method Parameters window. The Resource Comments tab opens as shown in Figure 66.

![Resource Comments Window](image)

Figure 66. Resource Comments Window

2 In the Select Resource drop-down list, select the name of the resource that you want to add a comment to.

3 Type the desired comment in the Edit Comment text box.
Adding Resource Comments to a Method (Continued)

4 Click the Apply button.

5 Save the method.

When the system operator opens the method in the Run Method window, a tab for the resource is displayed on the left side of the window and the comment reminds the user to perform the required actions.

Conditionally Executing an Instruction

If you only want an instruction to be executed when an equation comparing two variables is True:

1 Select the instruction in the Method tab.

2 Click the Advanced tab in the Instruction Parameters window (see Figure 67).

3 Select the Use Following Condition check box.

4 Choose the name of the desired variable or parameter in the first drop-down list.

5 Choose the desired operand in the second drop-down list.

6 Choose the second variable or parameter in the third drop-down list. Both variables/parameters must be the same type, either Numeric or String.

7 Click the OK button on the Advanced tab to save the changes.

The equation is evaluated at run-time and is only executed when the equation evaluates to True. If the equation is False, iLink PRO skips the instruction and continues with the next instruction.
Example:
If the condition is `NumberOfHits != Zero`, where `NumberOfHits` is a String variable that is set by another instruction and `Zero` is a String variable set to 0, then the instruction will only be executed when `NumberOfHits` is not equal to 0.

Changing the Instruction Duration

The Instruction Duration specifies how long the instruction should take to complete. The system Integrator sets the default value, but if you use variables or parameters to choose settings for the instruction, the actual instruction duration may change. If the instruction duration is too short, iLink PRO may generate an error that the instruction did not finish on time. If the instruction duration is too long, the system may wait until the full instruction duration time has elapsed before continuing with the method (if the Drive Mode is set to Time).

1. Select the instruction in the Method tab.

2. Click the Advanced tab in the Instruction Parameters window (see Figure 68).

3. Verify that the instruction duration time displayed in the Instruction Duration text box is correct. If the instruction duration is different from the default, type the correct time. Instruction Duration format is hh:mm:ss, where hh is hours, mm is minutes, and ss is seconds.

4. If you want to specify the maximum time between when the instruction finishes and when the robot removes the material, type the desired time in the Delay Before Being Picked text box. This time is the maximum time that the material can be left in the instrument after the instruction is completed without affecting the assay. Delay time format is hh:mm:ss, where hh is hours, mm is minutes, and ss is seconds.
A Delay time of 00:00:00 indicates that there is no constraint on time and the material can be left in the resource as long as necessary to optimize the method.

NOTE

Drive Mode must be set to Time (not Event) for the Delay Before Being Picked settings to be used. See “Choosing the Method Scheduling Options” on page 90 for details.

5 Click the OK button on the Advanced tab to save the changes.

Executing an Instruction Only During Specific Runs

If an instruction should only be executed during specific runs:

1 Select the instruction in the Method tab.

2 Click the Periodicity tab in the Instruction Parameters window (see Figure 69).

3 If the instruction is performed on every Nth run:
   a Click the Every Nth Run option.
   b Type the number of the first run in which the instruction is executed in the Start Run text box.
   c Type the N value of the runs in which you want to execute the instruction in the N= text box. For example, if Start Run is 3 and N= 3, the instruction is performed in runs 3, 6, 9, 12, etc. Runs 1, 2, 4, 5, 7, 8, 10, 11, etc. are skipped.
d If the instruction is a Move instruction that loads or unloads a material into an instrument, and the material remains in the instrument for multiple runs, check the **Use in Multiple Runs** check box.

4 If the instruction is performed in a range of runs:

a Click the **Run Range** option.

![Start Run 1 End Run 1]

b Type the number of the first run in which to execute the instruction in the **Start Run** text box.

c Type the number of the last run in which to execute the instruction in the **End Run** text box. For example, if Start Run is 5 and End Run is 8, then the instruction is performed only in runs 5, 6, 7, and 8.

5 Click the **OK** button to save the settings.

## Creating New Data Configurations

iLink PRO provides the Data Configuration wizard to enable you to create customized data files from the data that is generated during method execution. The custom data files can be saved in any combination of the following formats: Text, XML, or Excel. You can choose when the data file is created and which instrument's data is saved to the file.

1 In the Method Editor window, select **Tools → Data Setup** to open the Data Setup window as shown in **Figure 70**.

![Figure 70. Data Setup Window]

2 Click the **New** button to open the **New Data Configuration** wizard as shown in **Figure 71**.
Creating New Data Configurations (Continued)

3 Type the desired name for the data configuration in the Name text box and if desired, type a description of the data configuration in the Description text box.

4 Click the Next button to display the Save Data Frequency window.

5 Select how often you want a new data file created: After Every N Runs, at the end of execution of each method or method set Application, or after Each Instruction. Each time the data is written, a new data file is created.

6 Click the Next button to display the Text Data File window.
Creating New Data Configurations (Continued)

7 To create a text file that contains the data, type the desired path and name of the data file into the Filename text box. You must include the .txt extension. The file name will be appended with the date and time the run or instruction began execution, so that the data files will not be over-written.

To skip creating a data text file, leave the text box empty.

8 Click the Next button to display the XML Data File window.

9 To create an XML file that contains the data, type the desired path and name of the data file into the Filename text box. You must include the .xml extension. The file name will be appended with the date and time the run or instruction began execution, so that the data files will not be over-written.
Creating New Data Configurations (Continued)

To skip creating a data XML file, leave the text box empty.

10 Click the **Next** button to display the Excel Data File window.

![Figure 75. New Data Configuration Wizard](image)

11 To create an Excel file that contains the data:

a Type the desired path and name of the Excel Workbook into the **Workbook** text box. You must include the .xls extension. The file name will be appended with the date and time the run or instruction began execution, so that the data files will not be over-written.

b Specify the desired Worksheet name in the **Worksheet** text box.

c Specify the **Delimiter** you want to use in the Excel File. The default delimiter is a comma, but if the data will contain commas, you should use a different delimiter to ensure the data is formatted correctly.

To skip creating an Excel data file, leave the text boxes empty.

12 Click the **Next** button to display the Choose Instrument Data window.
Creating New Data Configurations (Continued)

13 Select the check boxes next to the instruments that you want to capture data from. The System Log will save all system command data for each instruction.

14 Click the **Finish** button. The new Data Configuration is displayed in the Data Setup window.

15 Create additional Data Configurations as needed by repeating this procedure, if desired.

16 When done, click the **OK** button on the Data Setup window.

17 See “Choosing the Data Configurations for a Method” on page 104 to set up the method to use the data configurations.
Choosing the Data Configurations for a Method

Once you have created the desired data configurations to capture and save the data, you must set the method to use the desired data configuration.

To choose the data configurations to use for a method during method execution:

1. Open the method in the Method Editor window.
2. Click on the **Data Configuration tab** in the Method Parameters window as shown in Figure 77.

![Figure 77. Data Configuration Tab](image)

3. Select the check boxes for the data configurations that you want to use while the method is executing.
4. Save and schedule the method (see page 108).
Opening a Method

You can have multiple methods open in the Method Editor window. Use the minimize and maximize buttons on the Method windows to resize the windows. Use the Windows menu to view open methods.

To open a method:

1. On the Method Editor window, select File → Open or click the Open button on the tool bar. The Open window displays the names of all methods in the default Methods folder.

2. If the desired method or method set is not saved in the default method folder, navigate to the folder where the method is saved.

3. Click the name of the desired method or method set.

4. Click the Open button. The selected method is displayed in a Method window in the Method Editor window. The title bar at the top of the Method window displays the method name.
Editing a Method

To edit a method, the method must be open in the Method Editor window. If you change a method, you must re-schedule or re-sequence the method when saving the changes. The Method Editor window provides standard editing functions to edit methods, such as Cut, Copy, Paste, and Delete. These functions are available on the Edit menu or on the tool bar.

Copying an Instruction in a Method

1. Click the instruction in the Method window to select it.
2. Click the Copy button on the tool bar or select Edit→Copy.

Pasting an Instruction into a Method

1. Click an instruction in the Method window to select the location to paste. The copied instruction is inserted above the selected instruction. If no instruction is selected in the Method window, the copied instruction is inserted at the end of the method.
2. Click the Paste button on the tool bar or select Edit→Paste.

Deleting an Instruction from a Method

1. Click an instruction in the Method window to select it.
2. Click the Delete button on the tool bar or select Edit→Delete.

Changing the Parameters for an Instruction

1. Double-click the instruction in the Method window. The Operation Parameters window displays the parameters that can be set for the instruction.
2. Adjust the parameters as desired.
3. Click the OK button. The Method Editor window displays the instruction with the new parameters in the Method tab.
Adding Additional Materials to a Method after Saving

To add a material to the Initial Layout of Materials after saving or editing the method:

1. Click on the **Initial Layout of Materials** instruction on the Method tab
   OR
   Click the **Prev** button on the Material Layout diagram until the layout is available for editing (the Done button displays).

2. Click and drag the new material into the Layout diagram. If placing multiple materials into the same storage locations, see “Example: Adding Multiple Materials to Twister II Racks” on page 82 for tips. If there are conflicts with an existing step in the method, a message displays the step where the conflict occurs. Click the **OK** button to dismiss the error and continue.

3. When the new materials are added, click the **Done** button.

4. Add/delete instructions in the method so there are no material conflicts.

5. Save the method. If you know there are still material conflicts in the method, you should save without scheduling (select the Skip Scheduling Validation check box). (Remember you must schedule before you can run the method.)

Deleting Materials from a Method

To delete a material to the Initial Layout of Materials after saving or editing the method:

1. Click on the **Initial Layout of Materials** instruction on the Method tab
   OR
   Click the **Prev** button on the Material Layout diagram until the layout is available for editing (the Done button displays).

2. Click and drag the material that you want to delete into the Blue trash bin on the Layout diagram. The Delete Material Confirmation message displays. Click OK to delete the material.

3. Click the **Done** button. If there are Move instructions in the method that move the material, the move instructions are deleted from the method.

4. Note that any instructions used to process the material will remain in the method. Check the method carefully and delete any unnecessary processing instructions.
5 Save the method. If you know there are still unnecessary instructions in the method, you should save without scheduling (select the Skip Scheduling Validation check box). (Remember you must schedule before you can run the method.)

Saving a Method

To save changes to a method:

1 Click the **Save** button on the tool bar or select **File→Save**. The Number of Runs window opens.

2 Type the number of runs for which to schedule or sequence the method in the **Number of Runs** text box. Each run is one complete execution of the method.

3 You must schedule a method that you are going to run. If you do not want the method to be scheduled, select the **Skip Scheduling Validation** check box. (For example, if you are saving a method that is not yet completed.)

4 Click the **OK** button. The method is automatically scheduled or sequenced based on the options selected on the **Schedule Type** tab in the Method Parameters window. A status window displays the progress of scheduling or sequencing the method.

5 When scheduling or sequencing is complete, the method is saved.

6 You can view the Gantt chart for the method (see page 112) or run the method in the Method Editor (see page 124).

7 To run the method in the Run Method window, see page 131.

To change the scheduling options, see page 90.

To set up the materials in a storage instrument, see page 109.
Setting Up the Materials in a Storage Resource

The iLink PRO software uses the Storage Setup to determine the correct position from which to retrieve a material in a random storage instrument like an incubator. If the Storage setup does not match the actual positions of the materials, incorrect materials will be processed or the run will fail because the robot tries to retrieve a plate from an empty position.

If you are using a storage instrument to hold multiple materials at the start of a run and the storage instrument is a random access instrument like the incubator, you must change the Storage Setup to match the positions of the materials in the instrument after the method is saved. You do not have to make any changes in this window if the materials are in the Twister II storage racks.

When you add multiple materials to a storage instrument, the default material setup is for each material to immediately follow the previous material as shown in Figure 80.

![Initial Storage Setup window](image)

In the example above, the first position that Material2 is located in is position 31.

**If you want to change the first position of Material2,** click on the material icon on the right side of the window (as shown in Figure 81 on page 110, the cursor changes to a pointing hand), and drag Material2 down to the desired starting position.
Setting Up the Materials in a Storage Resource (Continued)

If you drag Material2 down to position 50, the Storage Setup will display the materials as shown in Figure 82 and when the iLink software processes the instruction to retrieve the first Material2 from the incubator, Material2 will be retrieved starting at position 50 in the incubator.

Figure 82. Material2 with New Starting Position
Setting Up the Materials in a Storage Resource (Continued)

To interleave (mix) materials in the same rack in a storage instrument, click on the material icon (see Figure 81), and drag on top of Material1. Watch the Begin number - Begin=1 will put Material2 in position 1 and Material1 in position 2; Begin = 2 will put Material2 in position 2 and Material1 in position 1. When you drop the Material2 icon, a message box displays as shown in Figure 83.

Figure 83. Interleaved Message

Click the OK button to interleave the materials in the storage instrument. The Storage Setup window displays the interleaved materials as shown in Figure 84.

Figure 84. Material1 and Material2 Interleaved
Viewing Gantt Charts

The Static Chart Viewer displays a Gantt chart representing the scheduled or sequenced method that is currently open in the Method Editor window.

The Static Chart Viewer window opens automatically when you open the iLink PRO software. To view a gantt chart for a method that is already open in the Method Editor window, click the View Gantt Chart button on the tool bar.

Figure 85 shows the Gantt chart with a method schedule open.

![Gantt Chart Tab](image)

Figure 85. Gantt Chart Tab

You can use the Gantt chart to view the schedule and decide whether to change the scheduling or timing options to make the method execution more efficient.

This section includes:

- “Opening a Scheduled Method in the Chart Viewer” on page 113
- “Comparing Methods in the Chart Viewer” on page 114
- “Changing a Resource’s Color” on page 114
- “Closing a Gantt Chart” on page 115
- “Changing the Chart Viewer Settings” on page 115
Opening a Scheduled Method in the Chart Viewer

To open a scheduled method in the Chart Viewer:

1. Click the **Open** button on the Chart Viewer main window to display the **Select Open Method** window as shown in **Figure 86**. The Select Open Method window displays the scheduled methods that are open in the Method Editor window. To open a method that is not open in the Method Editor window, click the **Others** button.

![Figure 86. Select Open Method Window](image)

2. Select the method that you want to open.

3. Click the **OK** button to display the scheduled method in the Chart Viewer window.

4. Right-click on an operation in the Gantt chart to display details about the operation.

5. To zoom in, click and drag the mouse to select the desired runs. To zoom out, click the **Full View** button. To view the last zoom level, click the **Previous View** button.
Comparing Methods in the Chart Viewer

The Chart Viewer has a Global View option, which “links” multiple methods so that the method windows use the same view settings. This allows you to zoom in/out, and scroll all Gantt charts at the same time to compare methods.

To compare method schedules:

1. Open the desired methods in the Chart Viewer window.
2. Zooming in/out or scrolling in any of the windows will change all of the windows to display the same settings.

Changing a Resource’s Color

To change the color assigned to a resource:

1. Open an application that uses the resource in the Chart Viewer window.
2. If the Colors pane is not displayed on the left side of the window, click the Show Colors button on the tool bar.
3. Double-click the colored square next to the name of the resource to display the Color window as shown in Figure 87.
4. Click on the color that you want to assign to the resource in the Color window.
5. Click the OK button to change the resource’s color in the Chart Viewer and in the Real-Time Gantt Chart.
Closing a Gantt Chart

1. To close the Gantt Chart for a method, click the Close button.

2. To minimize the Chart Viewer window, click the Close button (X) in the upper right corner of the window.

Changing the Chart Viewer Settings

The view settings for the Chart Viewer and for the Real-Time Gantt chart can be changed in the Gantt Chart Options window. Both views use the same settings.

To open the Chart Viewer Options window:

1. In the Chart Viewer window, select Chart→Options.

2. Click the Behavior tab in the Chart Viewer Options window.

3. If Zoom on Runs is selected, the number of runs displayed in the gantt chart is reduced when you zoom in (vertical zoom). If not selected, the number of runs displayed remains the same.

4. If Auto Scroll Time is selected, the time displayed in the gantt chart is reduced when you zoom in (horizontal zoom). If not selected, the time displayed remains the same.

5. Click the Appearance tab in the Chart Viewer Options window.
Changing the Chart Viewer Settings (Continued)

6 To display vertical grid lines (time) in the gantt chart, select the Enabled check box next to Time Major and Time Minor.

7 In the Time Major Spacing text box, type the number of seconds between each major (darker) time grid line.

8 In the Time Minor Spacing text box, type the number of seconds between each minor (lighter) time grid line.

9 To display horizontal grid lines in the gantt chart, select the Enabled check box next to Run Major.

10 In the Run Major Spacing text box, type the number of runs between each horizontal grid line.

11 To hide either vertical or horizontal grid lines in the Gantt Chart, clear the appropriate check box.

12 Click the Done button to save the changes.
Adjusting the Method

You may want to make adjustments to further optimize the run, such as increasing or decreasing delay times or changing the parameters for an operation. To change the parameters or delay time for an operation:

1. Open the method in the Method Editor window.
2. Select the instruction that you want to change on the Method tab.
3. To change the delay before being picked time, change the maximum amount of time the system can wait before removing the material from the instrument in the **Delay Before Being Picked** text box on the Advanced tab. Delay time format is **hh:mm:ss**, where **hh** is hours, **mm** is minutes, and **ss** is seconds. Delay times are only recognized in Scheduled methods, not in Sequenced methods.
4. Change any other parameters as desired.
5. Click the **OK** button. The Method window displays the instruction with the new parameters.
6. Click the **Save** button to save changes and schedule or sequence the method.
7. Continue adjusting the method until the desired result is achieved. Make sure to save the method after the last changes are complete.
Setting the iLink PRO Options

The Options window enables you to set options for the iLink PRO software such as default method directory, simulation mode, and Notification options.

To set the iLink PRO options:

1. On the Method Editor window, select **Tools**→**Options** to display the Options window.

2. See “Setting the General Options”, “Setting the Simulation Mode Options” on page 119, and “Setting Up the Alarm Notifications” on page 121.

3. Click the **OK** button to save the settings and close the Options window. These settings apply to all methods that you open or run.

Setting the General Options

The General tab on the Options window enables you to specify the directory where the iLink PRO methods are saved, the number of method names that are displayed in the recent methods list at the bottom of the File menu, and whether the system operator can start execution from the Select Method tab in the Run Method window.

To change the iLink PRO options:

1. On the Method Editor window, select **Tools**→**Options** to open the Options window.

2. Click the **General** tab as shown in **Figure 90**.

3. To change the default directory where the iLink PRO methods are saved, either type the desired path in the **Default Method Directory** text box, or click the **Browse** (…) button, select the desired directory, and click the **OK** button.
4 If you want a list of recently open methods to display at the bottom of the File menu, select the **Display Recently Used Methods** check box and type the number of method names you want displayed.

5 If you want the **Run Now** button to only be displayed on the Run Method tab in the Run Method window, select the **Enforce Sequential Setup in Run Wizard** check box. If you want the system operator to be able to start execution from any tab on the Run Method window, clear the check box.

6 To change the default instruction duration for all new instructions, type the desired value in the **Default Instruction Duration** text box.

7 Click the **OK** button to save the settings and close the Options window.

### Setting the Simulation Mode Options

When an instrument is in Simulation Mode and you are executing a method, the instructions are sent to the adapter software, but are not sent from the adapter software to the instrument ICP software. The instrument does not receive any instructions from iLink PRO, so the instrument does not move. The adapter software sends an OK status back to the iLink PRO software indicating that the instruction was completed successfully.

Simulation mode enables you to execute methods without the instruments moving. This can be useful during method development or troubleshooting.

To turn on Simulation Mode for instruments:

1. On the Method Editor window, select **Tools**→**Options** to open the Options window.

2. Click the Simulation tab as shown in **Figure 91**.
Setting the Simulation Mode Options (Continued)

3. Select the check box next to the instruments that you want to put into simulation mode. **Remember that instruments in simulation mode will not move, but instruments not in simulation mode will execute instructions when the method is executed.**

4. Click the **OK** button to save the settings and close the Options window.
Setting Up the Alarm Notifications

The iLink PRO software can send a notification to a designated email address, call a phone number, or run a program if an alarm displays in the alarms pane.

To set up the alarm notifications:

1. On the Method Editor window, select **Tools**→**Options** to display the Options window.

2. Click the **Notification** Tab (shown in Figure 92).

3. To send the notifications if an alarm occurs, select the **Enable Notification** check box. If you do not select the check box, the notifications are saved but will not be sent if an alarm occurs.

4. If you want to attach a copy of the execution log file for the method or method set, select the **Attach Run Time Log** check box.

5. If you want the subject of the email to contain the type of error that occurred, select the **Append Details to Subject** check box.

6. If you want the body of the email to contain the Run ID, Instruction ID, Computer Name, name of the resource that generated the error, and type of error that occurred, select the **Append Details to Message** check box.

7. Click the **Setup Notification** button to open the Notification Settings window (shown in Figure 93 on page 122).
Setting Up the Alarm Notifications (Continued)

![Notification Settings Window]

8 Choose the desired combination of email, phone number, or programs as described below.

9 **To email a notification if an alarm occurs:**
   a Type the desired email addresses in the **Addresses** text box. Multiple email addresses must be separated with a semi-colon (;) without spaces between the addresses. If you do not want to send email, delete the text from the Addresses text box.
   b Type the subject for the email in the **Subject** text box.
   c Type the desired text for the email in the **Message** text box.
   d If you want to attach a file to the email, click the **Attachments** button and select the desired attachments.
   e If desired, click the **Test Email** button to send an email to the specified addresses.

10 **To dial a phone number if an alarm occurs:**
   a Type the number sequence to call in the **Numbers** text box. Type a comma (,) to pause for approximately 2 seconds between numbers, if needed. You can use numbers 0 through 9, parentheses, spaces, and dashes in the Numbers text box. Multiple phone numbers must be separated with a semi-colon (;). Parentheses, spaces, and dashes are ignored.
   b If desired, click the **Test Modem** button to dial the number displayed.
Setting Up the Alarm Notifications (Continued)

11 To run a program if an alarm occurs:
   a Type the path and file name of the program in the Programs text box or click the Programs button to browse for the file. Multiple files must be separated with a semi-colon (;).
   b If desired, click the Test Run Program button to run the selected program.

12 Click the OK button to save the notification settings, close the window and display the Options window.

13 Click the OK button on the Options window to close the Options window and display the Method Editor window.

Closing the Method Editor Window

1 To close the iLink PRO software, choose File→Exit OR to close the Method Editor window and open the Run Method window, choose Tools→Select and Run Wizard.

2 To create a method set that runs multiple methods, see “Developing Method Sets” on page 126.

3 To execute a method or method set, see “Running a Method” on page 131.
Importing/Exporting Methods

Methods can be transferred from one computer to another by copying and pasting the method files and/or resource file.

Before moving method or system setup files, make backup copies of all *.mth and resources.xml files.

**To transfer a method file**, find the *.mth file with the same name as the method, copy the file, then paste to the desired location.

- If both computers have the exact same instruments in the System Setup and all of the instrument names, settings, and capacities are the same, you can open and run the method.
- If the Instrument names are different, when you open the method you must create a new instruction to use the correct resource.
- If the capacity of a storage instrument is different, you should resave the method for a number of runs compatible with the new storage instrument capacity.

**To transfer a system setup**, copy and paste the resources.xml file to the desired computer. The exact same resource kits and instrument setup (INI) files must be present on both computers for iLink PRO to start properly.

Running Methods from the Method Editor Window

When developing methods in the Method Editor window, you can run the methods directly from the Method Editor window (without having to switch to the Run Method window).

Use the method execution buttons on the Method Editor window toolbar to Start, Pause, Resume, Finish, or Stop the method execution. For details on the function of these buttons, see page 141 through page 144.

The Schedule tab in the Method window enables you to view all of the instructions in the scheduled method.
Viewing the Editor Log

iLink PRO logs all editing activities that are performed in the Method Editor window. The log is displayed in the Method Parameters window on the Log tab. If you need to view the saved log file, the log file is located in the \iLink PRO\Log\Editor\ folder and can be opened with a text editor such as Notepad.
Developing Method Sets

Overview

This section describes how to create method sets that can be run in the iLink PRO software.

Once the system setup and the methods have been created, the integrator can create a method set in the iLink PRO software. The method set contains a sequence of methods that will be executed in the order they are listed in the method set.

When the method set is saved, the operator can run the method set in the Run Method window simply by selecting the method set, supplying any necessary instrument method names or variable values, and clicking the Run or Run Now button.

To create a new method set, see “Creating a New Method Set” on page 127.

To edit a method set that has already been created, see “Editing an Existing Method Set” on page 129.

To execute a method set, see “Running a Method” on page 131.
Creating a New Method Set

The integrator can create method sets that the operator runs. The method set includes the list of methods that will run, in the order that they will be run. You can add multiple methods to the method set, and when the method set is executed, the methods will be executed in order. The next method in the method set does not start execution until the previous method is complete.

1 Start the iLink PRO software (see page 132) and click the Edit Method button on the Startup window to display the Method Editor window.

2 Choose File→New Method Set. The Method Set Editor window displays as shown in Figure 94.

3 To add the methods to the method set:
   a Click the Add button on the Method Set Editor window. The Open window displays the methods that have been saved.
   b If necessary, navigate to the folder where the method is located.
   c Select the method that you want to add to the method set and click the Open button. The method is added to the method set.

   **NOTE**

   The starting positions of the materials in a method must be compatible with the ending positions of the materials in the previous method. iLink PRO does not verify the ending position of one method with the beginning position of the next method.
Creating a New Method Set (Continued)

4 To move a method up or down in the list, select the method and use the Up or Down arrow buttons to move the method to the desired location.

5 To change the method execution parameters for a method, right-click on the method name and choose Parameters on the shortcut menu. The Method Set Parameters window opens as shown in Figure 95.

6 If you want to start with a run other than run 1, enter the desired number in the Starting with Run text box.

7 If you want to run a specific number of runs, choose the Number of Runs option and enter the desired number in the text box.

8 If you want to stop execution at a specific run number, click the Ending with Run option and enter the desired number in the text box.

9 See “Saving a Method Set” on page 130.
Editing an Existing Method Set

To edit an existing method set:

1. Choose File→Open on the Method Editor window to display the Open window as shown in Figure 96.

![Figure 96. Open Method Set Window](image)

2. In the Files of Type drop-down list, select Method Set Files.
3. Select the name of the method set that you want to open.
4. Click the Open button to display the selected method set in the Method Set Editor window.
5. Make the desired changes to the method set.
6. See “Saving a Method Set” on page 130.
Saving a Method Set

To save changes to an existing method set or to save a new method set:

1. Click the OK button at the bottom of the Method Set Editor window. The Save Method Set window displays as shown in Figure 97.

![Figure 97. Save Method Set Window](image)

2. To save a new method set, type a unique name for the method set in the Method Set Name text box. To save changes to an existing method set, leave the name in the Method Set Name text box unchanged. To rename an existing method set, type the new name in the Method Set Name text box.

3. If desired, type a description in the Method Set Description text box.

4. Click the Save button on the Save Method Set window. The Save Method Set window closes and the Method Editor window displays.

Closing the Method Editor Window

1. To close the iLink PRO software, choose File→Exit OR to close the Method Editor window and open the Run Method window, choose Tools→Select and Run Wizard.

2. To execute a method or method set, see “Running a Method” on page 131.
Running a Method

Overview

This section describes how to run a method or method set in the iLink PRO software.

Once the method or method set has been created by the system integrator, you use the iLink PRO software to run the method and to control and monitor the run. If the desired method or method set has not been created, a trained system operator should create the desired method. For information about integrating the system, see “Integrating the System” on page 38, “Developing Methods” on page 76, and “Developing Method Sets” on page 126.

Turning the System ON

WARNING

The robot may move when the power is switched ON. Always keep body parts, hair, jewelry, and clothing away from the robot while it is operating. Instruments in the system may move unexpectedly. Keep all objects out of the path of the robot arm. Failure to do so may cause injury.

1 Turn ON the computer.

2 Press the Power Switch on the front of the Twister II pod to the ON (1) position. The green power indicator lights up, indicating the robot is ON.

3 Turn ON the other instruments in the system.
Starting the iLink PRO Software

To start the iLink PRO software:

1  Either:
   • On the Windows task bar, select Start→Programs→Caliper→iLink PRO→iLink PRO
   • Double-click the iLink PRO icon on the desktop.

   The iLink PRO software starts and displays the Startup window as shown in Figure 98.

   ![Figure 98. Startup Window](image)

2  If you want to run a method, click the Run Method button and see “Opening a Method or Method Set” on page 133.

   If you want to edit a method, click the Edit Method button and see “Developing Methods” on page 76.
Opening a Method or Method Set

The method or method set that you want to execute must be open in the Run Method window. A method set includes multiple methods that are run one at a time in the order shown.

To open the desired method or method set:

1. On the Run Method window, click the Select Method tab. The Select Method tab displays the methods and method sets that have been created in the default method directory as shown in Figure 99.

2. To open a method set, select Method Set Files (*.mst) in the Files of Type drop-down list.

3. If the method or method set is not located in the current folder, navigate to the correct folder.

4. Click on the name of the method or method set that you want to run and click the Open button. Tabs are displayed on the Run Method window for each step required to set up and run the method as shown in Figure 100 on page 134.
Opening a Method or Method Set (Continued)

5 If you want to run the method with the default parameter values, and the materials are already properly positioned in the instruments, click the Run Now button and see “Starting the Run” on page 141. Otherwise, go to step 6.

6 Click the Next button at the bottom right side of the window to display the next tab or click on the next tab on the left side of the window.

If the next tab is the Twister II Storage Rack tab or a storage instrument tab, see “Loading the Materials into the System” on page 135.

If the next tab is the Setup Parameters tab, see “Changing Parameters” on page 140.
Loading the Materials into the System

For each storage instrument that has materials in the instrument at the beginning of a method, a tab is displayed in the Run Method window. The name of the tab is the same as the name of the instrument in the iLink PRO system setup.

Each storage instrument tab shows where to place the materials to run the open method or method set. The Material Placement list displays the material names and position or rack number for each material. The Layout diagram displays a graphical view of the same information.

To put the materials into the initial material locations:

1. Open the desired method in the Run Method window and click the **Next** button to display the first storage instrument tab. (The name of the tab is the same as the name of a storage resource in iLink PRO system setup.) The Material Placement list (see Figure 101) shows the materials required for the method (or for the first method in a method set) and the locations where the materials should be placed to start the run. Figure 101 shows a StackStorage tab with materials in the Twister II racks.

![Figure 101. Material Placement List](image)

2. The Layout diagram displays a graphical view of the instrument and the material positions. The list on the left corresponds to the diagram on the right.

   In the example shown above, note that you must put a tip base into rack 8 so that the empty tip carriers can be stacked in the rack properly.
Loading the Materials into the System (Continued)

3 Place the materials into the locations as shown in the Material Placement list. If you are using a Twister II, see “Placing the Racks onto the Twister II Pods” on page 138 for details on loading the Twister II racks. If two materials are shown in the same locations, the materials must be placed in the locations in the order determined by the integrator.

- Make sure to place the materials so that well A1 on each material is positioned properly.
- If using a material (or multiple materials like plates with lids) in more than one rack in the Twister II, you must fill the first rack before adding plates to the next rack.

**Example:** If you are using rack 2 and 3 for lidded plates, rack 2 must be filled with lidded plates before any additional plates can be placed in rack 3. Rack 2 cannot be partially full if there are plates in rack 3.

- When using the Twister II racks, make sure that only the exact same plate type and part number are in a rack, with the exception of lids.

**Example:** If you are placing 96 well plates into a Twister II rack, you may only place that type of plate, and its lids, into that rack. More specifically, **two plates with the same specifications but from different manufacturers may not be used interchangeably.** Daughter A and Daughter B plates, if they are in the same rack, must be the same plate type, from the same manufacturer, with the same part number.

- Make sure to stack the materials in the proper order. The system integrator determines the order of the materials.

**Example:** In the list shown in Figure 101, the plates in Rack 3 must consist of pairs of DaughterA and DaughterB plates. The integrator must provide instructions telling the operator whether DaughterA or DaughterB should be at the top of each pair of plates.

- Make sure that any Twister II racks marked as Output racks or empty locations in the Layout diagram are completely empty.

- Make sure the materials do not extend above the top of the Twister II rack. If the materials are stacked higher than the top of the rack, the run will fail.
WARNING

- **BIOHAZARD** Wear gloves during any procedure that could involve contact with hazardous materials or fluids.
- **Ensure that the bottom of each material is dry. Fluid on the bottom of a material may present a contamination hazard. Use proper laboratory practices when handling any hazardous materials.**

4 If you are running a method set with multiple methods, click the **Methods** drop-down list at the top of the tab and select the name of each method in the method set to display the materials required for each method.

5 When the materials have been placed in the locations shown in the Material Placement list, click the **Next** button.

6 If the method has another storage instrument displayed, repeat this procedure for each storage instrument to load the materials into the correct locations.

   If the next tab is the Setup Parameters tab, see “Changing Parameters” on page 140.

   If the next tab is the Run Method tab, see “Starting the Run” on page 141.
Placing the Racks onto the Twister II Pods

This section describes how to place the racks onto the Twister II pods. The racks can be loaded with microplates either before or after you put the racks onto the pods.

**WARNING**

- **BIOHAZARD** Wear gloves during any procedure that could involve contact with hazardous materials or fluids.
- Ensure that the bottom of each material is dry. Fluid on the bottom of a material may present a contamination hazard. Use proper laboratory practices when handling any hazardous materials.

![Figure 102. Detachable Rack](image)

1. Holding the rack by any two handles and facing the pod and robot, hold the rack over the desired position.

2. Lean the top of the rack toward you slightly. If the rack contains full microplates, be careful not to spill the contents of the plates.

3. Place the rack locator notch (see Figure 102) under the lip of the rack position (see Figure 103 on page 139).
Placing the Racks onto the Twister II Pods (Continued)

4 Keeping the rack under the lip, pulled toward you, lean the rack forward and snap it into place against the locator pin.

Before releasing the rack, make sure it is secured by the locator pin by gently pulling it toward you. Release gently in order to maintain the proper rack position.

NOTE

Failure to release the rack in a snug position **pulled toward you**, under the lip, may misalign the racks and cause the robot to hit the racks.

5 Repeat for each of the racks. Make sure any required empty Output racks are placed properly to receive processed plates.

NOTE

Once a run is started, do not add or remove plates from either the Input or Output racks.

To remove a rack from the pod:

1 Gently pull the top of the rack toward you to disengage the locating pin.

2 Holding the rack firmly by two handles, gently lift the rack up and slightly away from you to disengage the bottom of the rack from the lip.
Changing Parameters

Use the Setup Parameters tab in the Run Method window if you want to run a different instrument method or change a parameter value in a method or method set. If the Setup Parameters tab is not displayed, the method does not have any parameters that can be changed. See “Starting the Run” on page 141.

To change the parameter value in the method or method set:

1. Click the **Next** button or the Setup Parameters tab to display the parameters that can be changed for the method or method set.

2. If a method set is open, select the method that contains the parameters in the **Method** drop-down list. The parameters for the selected method are displayed in the Parameters list.

3. Click in the **Value** column of the parameter that you want to change. Either a drop-down list or a text box becomes active for the parameter value. If the desired parameter name is not visible, use the scroll bar on the right side to scroll through the list.

4. Type the desired value in the text box or select the desired value from the drop-down list box.

5. Repeat steps 2 - 4 for any other parameters that you want to change. Make sure the desired parameter values are selected for each method in a method set.

6. When the desired parameter values are selected, click the **Next** button and see “Starting the Run” on page 141.
Starting the Run

When the desired method or method set is open, the materials are correctly placed in the system, and the parameter values are set, you can start the run.

To start the run:

1. Follow any setup procedures required for the method, such as filling reagent bottles, emptying waste containers, etc.

2. Click on the Run Method tab.

3. If you only want to execute some of the runs that were scheduled, change the number in the # of Runs text box to the number of times you want the method to be executed.

   If running a method set, choose each method name from the Method drop-down list and set the desired number of runs. If the number of runs is greater than the number of materials in the system and a method set is open, the next method in the method set will begin when the previous method completes.

4. Verify that the first instruction in the method is highlighted. (If a method set is open, make sure the first method in the method set is displayed and the first instruction is highlighted.

5. Click the Run button on the Run Method tab.
Starting the Run (Continued)

6 Watch the system process the first plate to ensure there are no problems. The Run Method tab displays the current status of each instruction by changing the icon next to each instruction. The icons are:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Instruction not started executing.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Instruction is in progress.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Instruction was completed successfully.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Instruction was not completed because an error occurred.</td>
</tr>
</tbody>
</table>

7 To view the execution log and data log while the method is running, click the View Data button at the bottom of the Run Method window.

8 To view the Real-Time Gantt chart, which shows the progress of the run on a Gantt chart, click the Gantt Chart button.

9 If an error occurs during the run, an alarm window displays a description of the error. If an alarm occurs, see “Recovering From an Error” on page 164.

![Image] Figure 106. Alarm Window
Starting the Run (Continued)

10 The method will process all of the plates in the system. When execution is complete, a message box displays a message that the method or method set is complete.

NOTE

- Do not use or close the instrument ICPs while they are running under automation control software. The automation control software must have complete control over the ICPs during execution.
- Once execution starts, do not add or remove plates from the input or output racks and do not interfere with the movement of the instruments or the robot.

Pausing the Run

The execution of a method can be paused and then resumed from the current position. To pause the execution:

Click the **Pause** button.

The run stops after all instructions currently in progress are complete.

**WARNING**

*The Abort Execution button in the Sciclone software or the Sciclone Emergency Off buttons only stop the Sciclone operation. When the Sciclone is running under iLink PRO, you must immediately pause the iLink PRO execution, as described above, when you use the Abort Execution button in the Sciclone software or the Sciclone Emergency Off button. Failure to do so may result in a crash or injury.*

Resuming the Run

To resume a paused run:

- Click the **Continue** button.

The method execution continues from the last instruction that was executed.
Stopping the Twister II Robot Immediately

If you need to stop the Twister II robot BEFORE it completes a move that is already in progress, (for example if the robot doesn’t grip a plate correctly and you want to stop the robot before the plate hits another system component), you can stop the robot immediately:

1 Click the Twister II Robot ICP button on the Windows task bar, or click the Twister II Robot ICP button on the Run Method window tool bar to display the Twister II Robot software.

2 On the Manual Controls tab, click the **Abort Move** button. The robot stops immediately and an alarm displays in the iLink PRO software.

To recover after stopping the robot:

1 On the Manual Controls tab in the Twister II Robot software, use the controls to move the robot to a safe position above the racks.

2 If the robot is gripping a plate, hold the plate and click the **Open Grip** button to release the plate.

3 Place the plate in the location indicated on the Alarm window depending on whether you want to Skip or Retry the instruction. (You may need to use the instrument ICP software to position the instrument properly to receive the plate.)

4 Click either the **Skip** or **Retry** button on the Alarm window.

Finishing the Current Run

To finish the current run:

- Click the **Finish** button.

Any runs that have been started will be completed. No new runs or methods will begin execution. Once a method is stopped, it can not be resumed.

Ending the Run Immediately

To end the run immediately:

- Click the **Stop** button.

Any instructions that are currently in progress will be completed, but no new instructions or moves will begin. Once a method is stopped, it can not be resumed.
Viewing the iLink PRO Runtime Log Files

The iLink PRO software generates a Runtime log file for each method or method set that is executed. The Runtime log is a tab-delimited text file that contains information, such as the execution status, start times, finish times, etc. about all instructions in the method. The default location of the Runtime log files is C:\Program Files\CaliperLS\iLink PRO\Data\. Each Runtime log file name is the method name followed by the date and the time the execution started.

To view a Runtime log file after execution is finished:

- Use My Computer or Windows Explorer to navigate to the directory where the log files are saved and then double-click on the log file that you want to view.
- Open the log file in a text-processing program such as Microsoft Word or Notepad.
- Open the log file in a spreadsheet program such as Microsoft Excel.

Closing the iLink PRO Software and Turning the System OFF

1. Choose File→Exit. The iLink PRO software closes. The iLink PRO software shuts down in the background and takes a few seconds to close all of the associated components. Wait a few seconds (depending on your computer speed) before restarting iLink PRO.

2. Turn off the instruments in the system.

3. Turn off the computer.
Twister II Hardware

This section describes the Twister II hardware and includes the following sections:

- **Overview** (below)
- “Robot Parts and Functions” on page 147
- “Pod Parts and Functions” on page 150
- “Rack Parts and Functions” on page 156
- “Communications Cable” on page 157
- “Power Cord” on page 157
- “Optional Components” on page 157

Overview

The standard Twister II material handling system includes the following hardware:

- **Robot** - Canister and tower that contain the mechanisms that direct all motion, including the Robotic Arm.
- **Pod** - Base that holds the racks.
- **Racks (3)** - Racks that hold various types of materials. The top of the materials in the rack can not extend above the top of the rack. Additional pods can be added for a total of up to nine racks.

*Figure 107* shows the parts of the Twister II.
Robot Parts and Functions

Robot Axes

The Twister II robot is a cylindrical robot with five separate axes. A home sensor determines the home location for each axis of motion. Figure 108 shows the five axes. A description of each axis follows the figure.

Reach
The Reach axis moves the grip horizontally. The reach, measured from the center of the robot post, has a range of 11.25 inches away from the center to 19.75 inches away from the center. The total span is 8.5 inches.

The Twister II robot uses the reach movement to place materials at variable distances, which enables the additional capacity of the three-rack pod arrangement. The reach movement also enables delivery and retrieval of materials to devices that are placed at variable distances from the Twister II.

Vertical
The Vertical axis moves the arm up and down. The span is 21.75 inches, from 6.5 inches away from the base up to 28 inches away from the base.

The Twister II vertical span provides the ability to place external devices at varying heights.
**Rotary**

The Rotary axis rotates the arm horizontally around the base of the robot. A mechanical stop prevents continuous rotation. The $340^\circ$ rotation provides the ability to deliver and retrieve plates to any point around the circumference of the Twister II.

The position above each of the rack locations and instruments must be taught after hardware and software installation.

**Grip**

The Grip consists of two fingers whose design ensures a secure grip on the sides of the material. When a vertical move brings the arm and wrist assembly in contact with a plate, the vertical motion stops and the fingers grasp the plate.

**Wrist**

The Wrist mechanism rotates materials to either portrait or landscape position. The range of motion is $\pm 135^\circ$ ($270^\circ$ total). The wrist feature provides easy integration with external devices.
Robot Canister

The robot canister is the base of the robot. The canister is used to secure the pod to the robot in a permanent, level position. For more information on the pods, see “Pod Parts and Functions” on page 150.

The canister has locking positions for three pods.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Securing Bracket Holes</td>
<td>Receptacles for the bracket assemblies that secure the pods to the canister.</td>
</tr>
<tr>
<td>Feet (3)</td>
<td>Support and level the robot.</td>
</tr>
<tr>
<td>Positioning Cups</td>
<td>Positions the robot on the table and prevents the robot from accidentally being moved. The robot feet are placed inside the cups after the cups are secured to the table in the correct locations.</td>
</tr>
</tbody>
</table>
Pod Parts and Functions

Pods are platforms attached to the robot that hold three storage racks. One pod (included with the Twister II) contains the power entry port assembly and provides power to the robot. Additional pods are available. The additional pods do not have power entry ports or electronics. There is a maximum of three storage pods per robot.

Rack Position Numbers

Pod positions are numbered in a clockwise order. Position 1 is the position closest to the Power Entry Port/Fuse assembly (see Figure 110). The remaining positions are numbered clockwise, continuing through all pod positions and additional pods.

Figure 110. Rack Numbers
Exterior Front View

The power switch is a rocker switch located on the outside of the pod that contains the power entry port.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Cover</td>
<td>Covers the top of the pod. Removable to access the screws to attach the pod to the robot base.</td>
</tr>
<tr>
<td>Power On LED</td>
<td>Green indicator light. When lit, indicates the Twister II is powered on.</td>
</tr>
</tbody>
</table>
| Power Switch    | Rocker switch labeled 1/0. When the switch is on (1), the LED light turns on.  
                  | Make sure the Twister II is positioned to allow access to the power entry module to easily disconnect or turn off/on the module. |
Exterior Rear View

The pod attaches to the robot base and holds three racks. The pod locks onto the robot base to prevent the racks from moving out of position relative to the robot.

One pod contains the power entry port and the power connections to the robot. Each Twister II robot must have exactly one pod with the power entry port.

![Pod with Power Entry Port](image)

**Figure 112. Pod with Power Entry Port**

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Securing Location</td>
<td>Location where the securing assembly locks the pod to the robot base.</td>
</tr>
<tr>
<td>Cable Location</td>
<td>Location of the power supply and communication cables that connect to the robot.</td>
</tr>
<tr>
<td>Power Entry Port/Fuse Assembly</td>
<td>Assembly that holds the communication port, power port, and fuse block.</td>
</tr>
</tbody>
</table>

**NOTE**

There is only one power entry port for the Twister II, regardless of the number of pods.
Top View

Figure 113. Rack Position

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Locator Lip</td>
<td>Holds the rack on the pod.</td>
</tr>
<tr>
<td>Rack Holding Pin</td>
<td>A retractable pin that presses against the base of the rack and assists in holding a rack on the pod.</td>
</tr>
<tr>
<td>Rack Locator</td>
<td>Centers the rack and assists in holding a rack on the pod.</td>
</tr>
</tbody>
</table>
Interior View

The pod locking mechanisms are located inside the top cover of the pod. These locking mechanisms ensure that the pods are firmly attached to the robot.

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pod Locking Cap Screw</td>
<td>Cap screw that locks the pod to the securing bracket assembly on the canister.</td>
</tr>
<tr>
<td>Connector Location</td>
<td>Location of the power and communication cable connectors that connect to the cable connectors in the robot canister.</td>
</tr>
<tr>
<td>Pod Locking Pin Screws</td>
<td>Metal pins that brace the pod against the robot canister and stabilize the pod.</td>
</tr>
</tbody>
</table>
Power/Fuse Assembly

The Power Entry Port/Fuse assembly is located on the side of one pod. There is always only one power entry port for the Twister II, regardless of the number of pods. Additional pods do not have power connectors.

![Diagram of Power/Fuse Assembly](image)

**Figure 115. Power/Fuse Assembly**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Port</td>
<td>9-pin communication cable port.</td>
</tr>
<tr>
<td>Power Entry Port</td>
<td>Connector for the power cable.</td>
</tr>
<tr>
<td>Fuse Cover</td>
<td>The fuse housing assembly. The fuse configuration must match the power supply, either 100/120/240V. If it does not match, you must change the fuse configuration. See “Changing the Fuse(s)” on page 159.</td>
</tr>
</tbody>
</table>
Rack Parts and Functions

Racks are removable aluminum frames used as input and output locations for the materials. The standard Twister II comes with three racks. Each rack has two side handles and one top handle to facilitate removal and transport.

You teach the rack positions using the Twister II Robot software. The racks are interchangeable, but each rack is marked with the pod position.

![Rack Parts Diagram]

**NOTES**

*Do not drop the racks. If the rack is out of shape, the robot will not properly place the materials.*

<table>
<thead>
<tr>
<th>Part</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Locator Notch</td>
<td>Locks the racks onto the pod in the proper position.</td>
</tr>
<tr>
<td>Side Handles (2)</td>
<td>Fixed handles for connecting or disconnecting racks from the pod.</td>
</tr>
<tr>
<td>Top Handle</td>
<td>Hinged handle for connecting or disconnecting racks from the pod.</td>
</tr>
</tbody>
</table>
Communications Cable

The communications cable connects the serial port on the side of the Twister II inclusive pod to a serial communications port on the computer. Only one fully dedicated serial communications port on the computer is required to connect the Twister II hardware to the computer. Additional communication ports are required to add additional instruments to the system.

Power Cord

The power cord plugs into the Power Entry Port on the side of one Twister II pod. Input line power of either 100/120 or 230V, 50 or 60 Hz, is required.

WARNING

- Use a standard IEC 320-style power cord appropriate for your country.
- Verify the voltage stated on the power entry port matches the voltage for your country. If the voltage is not correct, contact the Caliper Technical Support Center.
- Only plug the power cord into a properly grounded outlet supplying the correct voltage. Insert the three-pronged, grounded plug fully.

Optional Components

The following optional components are available from Caliper for use with the Twister II robot:

- Additional pods/racks
- Additional instrument software adapters

Please contact Caliper Sales for available instrument adapters.
Twister II - Maintenance

WARNING

- Turn OFF the power and disconnect the power cord from the power supply before performing any maintenance procedure that requires removal of any panel or cover, or disassembly of any interior instrument component.

- Removal of protective covers marked with the High Voltage warning symbol shown above can result in a safety hazard.

NOTE

All maintenance procedures described in this manual can be safely performed by qualified personnel. Maintenance not covered in this manual should be performed only by a Caliper representative. See “Contact Us” on page 10.

Cleaning the Twister II

WARNING

BIOHAZARD. Wear gloves during any cleaning procedure that could involve contact with hazardous materials or fluids.

The outside surfaces of the Twister II should be cleaned periodically. Use a cloth or sponge dampened with water, alcohol, glass cleaner, or a mild soap solution diluted with water. If using glass cleaner or mild soap, wipe with a damp cloth or sponge after cleaning to remove any residue. Do not use abrasive cleaners. Do not spray cleaner onto the instrument. Clean the gripper and the racks with alcohol or other residue-free solvent.

Wipe up any spills immediately. Clean only the exterior of the unit. Never remove any instrument panels to clean the inside of the instrument. Do not allow water or other fluids to drip inside the instrument.

Cleaning the Rack Base

The surface beneath the Twister II racks must be clean at all times. Debris or dust under the racks will cause misalignment between the robot and the racks.
Changing the Fuse(s)

Fuses:

- **100/120V operation**: (1) 3A, 0.25 in x 1.25in, Fast-acting
- **240V operation**: (2) 1.6A, 5mm x 20mm, SLO-BLO

The Twister II can operate at 100/120V using a single 3Amp fuse or at 240V using two 1.6A fuses. To change the fuses:

**WARNING**

- *Electrical shock hazard. Disconnect the power cord before changing the fuses.*
- *For continued fire protection and correct functioning of the unit, replace fuses only with fuses of the same type and rating.*

To convert to 240V fuse configuration:

1. Verify the Twister II power switch is OFF and the power cord is unplugged.

2. Using a small flat-blade screwdriver, gently pry the cover/fuse block assembly (see Figure 117) away from the power entry port housing.

3. Remove the fuse block/cover assembly from the housing.
Changing the Fuse(s) (Continued)

4 Remove the single 3Amp fuse or the two 1.6 amp fuses. Figure 118 shows the fuse location for a single 3Amp fuse for 100/120V configuration. Figure 119 shows the fuse locations for two 1.6Amp fuses for 240V configuration.

Figure 118. 100/120V Fuse Configuration

Figure 119. 240V Fuse Configuration

5 Confirm that the fuses are seated securely in the fuse block.

6 Snap the fuse block/cover assembly back into the housing. See Figure 117 on page 159.

Moving the Twister II

If you need to relocate the Twister II:

1 Remove all racks from the pods and materials from the racks. Reverse the hardware installation steps in the iLink PRO Installation Instructions.

2 Turn OFF the power

3 Unplug the power cord from the power outlet and from the receptacle on the side of the original pod.
Moving the Twister II (Continued)

4 Disconnect the communications cable from receptacle on the side of the original pod.

5 Prepare a space to accommodate the Twister II during the move (an empty area on the lab bench or a sturdy cart).

6 Disconnect all the pods from the robot canister.

WARNING

The Twister II weighs approximately 50 pounds (22.7 kg) and should be lifted with care. Take the proper precautions to avoid injury.

7 Lift the Twister II straight up and off the bench/table and set it carefully on the new bench or cart. Depending on the distance that you are moving the instrument, you may wish to repack the Twister II in its original shipping carton.

8 To re-install the Twister II, follow the instructions described in iLink PRO System Installation Instructions.

Long-Term Shutdown

If the Twister II will be unused for an extended period of time, clean the external surfaces of the instrument, follow the steps in “Moving the Twister II” to disconnect it, and cover it with a plastic or cloth cover.
Troubleshooting

Overview

This section describes how to recover from problems that may occur while operating the iLink PRO system. For more information on an individual instrument in the system, see the instrument’s user’s manual. For problems that are not listed here, contact Caliper Technical Support (see page 10).

iLink PRO Troubleshooting

Issue 1 iLink PRO cannot communicate with an instrument in the system

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument not powered on before starting the iLink PRO software.</td>
<td>Close the iLink PRO software, turn on the instrument, then start the iLink PRO software.</td>
</tr>
<tr>
<td>Communication cable not firmly attached.</td>
<td>Verify communication cable is inserted properly and seated securely in receptacle.</td>
</tr>
<tr>
<td>Instrument’s .ini file not named correctly.</td>
<td>Make sure the instrument’s .ini file is named the same as the resource name in the iLink PRO software.</td>
</tr>
<tr>
<td>Incorrect setting in the instrument’s .ini file.</td>
<td>Open the instrument ICP, open the .ini file that matches the name of the iLink PRO resource, set the required communication settings in the ICP, save the changes, and close the ICP. Dynamic instructions for integrating each instrument into the iLink PRO system are located in the instrument’s Integration Guide on the Resource Kit CD.</td>
</tr>
</tbody>
</table>

Twister II Troubleshooting

Issue 1 The Twister II does not turn on properly when switched on, or does not initialize.

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power cord not firmly attached</td>
<td>Verify Power cord is securely seated in receptacle.</td>
</tr>
<tr>
<td>Blown fuse</td>
<td>See “Changing the Fuse(s)” on page 159.</td>
</tr>
<tr>
<td>Fuse configuration not correct</td>
<td>See “Changing the Fuse(s)” on page 159.</td>
</tr>
<tr>
<td>Communication cable not firmly attached</td>
<td>Verify communication cable is inserted properly and seated securely in receptacle.</td>
</tr>
</tbody>
</table>
**Issue 2  The Twister II arm crashes.**

<table>
<thead>
<tr>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Twister II may have lost the proper orientation due to contact with an object in the arm's path.</td>
<td>Disable the servo motors using the Twister II Robot software. Manually move the robot to the proper position. Re-enable the servo motors. Run a check on the robot positions.</td>
</tr>
<tr>
<td>Robot positions not correct</td>
<td>In the Twister II Robot software, re-teach the instrument or storage positions.</td>
</tr>
<tr>
<td>Plates were added or removed during the run</td>
<td>Do not add or remove plates from the input or output racks during operation.</td>
</tr>
</tbody>
</table>

**Issue 3  The Twister II does not properly place materials into an instrument or the storage racks.**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Twister II is not placing the plates in the device correctly.</td>
<td>Re-teach the instrument positions (see “Re-Teaching the Instrument Positions” on page 167).</td>
</tr>
<tr>
<td>The plates are rubbing on the input or output racks.</td>
<td>Re-teach the storage positions (see “Re-Teaching the Storage Positions” on page 167).</td>
</tr>
<tr>
<td>The Twister II is not lowering the plates all the way down before releasing them.</td>
<td>Re-teach the storage positions (see “Re-Teaching the Storage Positions” on page 167).</td>
</tr>
</tbody>
</table>
Recovering From an Error

When a communication error or an error status is returned from a resource, the run pauses and iLink PRO displays an Alarm window as shown in Figure 120.

To clear an alarm:

1. If necessary, you can click either the **Pause** or **End Now** button on the Run Method window before you clear the alarm to either pause or stop the run after the error is cleared. You should pause the run if you skip an instruction and need to manually move resources or materials before you resume the run.

2. To determine the state of the instruments in the system, select **Resource→View State of All Resources**.

![Figure 120. Alarm Window](image-url)
Recovering From an Error (Continued)

3 Depending on the state of the instruments and instrument software, you may need to shut down, restart, and initialize an instrument before you can continue. In the iLink PRO windows, use the options on the Resource menu to shut down, restart, and initialize the instruments. Hide closes the ICP icon on the Windows taskbar, but the ICP does not shut down, it still runs in the background.

Adapters may not support all options on the Resource menu.

![Figure 121. Resource Menu](image)

4 The Alarm window shows the options for clearing the alarm (see Figure 120). The options depend on the severity of the alarm and the type of instruction that generated the alarm, and may include: Dismiss, Skip, Retry, Finish, and/or Stop.

5 Choose the desired option for recovering from the alarm. If you choose **Retry**, you may have to use the resource’s ICP software to stop, initialize, or reset the resource before you can retry the operation. If you choose **Skip**, you may have to use the resource’s ICP to complete the operation manually **before** you can resume the run.

6 If you are recovering from an error during a Move instruction (for example, if the robot drops a plate and generates an error) use the following tips to help you resume the run:

   a Retrieve the material and place it into the resource where it was located at the beginning of the move. **Watch out for moving resources!**
   
   b If necessary, use the resource ICP to move the resources to the position they were in just before the Move began. (For example, you may need to open a drawer or door.)
   
   c Move the robot to a safe position where it will not crash when moving to the source position of the move. It may be necessary to home and/or re-initialize the robot depending in the state of the robot and the cause of the error.
   
   d **Retry** the Move instruction.
Initializing the Resources

Initializing a resource runs a pre-defined initialization sequence for the instrument. The initialization sequence for a resource cannot be changed. All instruments in the system are initialized when the iLink PRO software starts.

To initialize a resource in the system:

1. Click the button on the tool bar that has the same name as the instrument.
2. Select Initialize from the drop-down menu.
3. Some resources may require additional initialization procedures or re-positioning before you can start the run. The User’s Manual for the resource will specify any additional initialization procedures.

Configuring ClickYes to Stop Outlook Error Messages

The ClickYes Utility is installed with iLink PRO to stop Microsoft Outlook from stopping a run in progress with an error message. If you are using the email Notification option and have a Microsoft Service Pack installed, Outlook may display the error message: “A Program is trying to access e-mail addresses you have stored in Outlook. Do you want to allow this?” when iLink PRO tries to send out the email notification. The ClickYes Utility will automatically click the Yes button in this Outlook message.

To configure ClickYes:

1. Right-click on the ClickYes icon on the Windows task bar.
2. Select Start on Logon.
3. Deselect (clear) Start Suspended.
4. Select Resume to start the utility if it is suspended.
Re-Teaching the Storage Positions

If you have added additional pods or racks to the Twister II or if the racks have been moved slightly and are not properly aligned with the robot, you should re-teach the storage positions. You can teach the storage positions with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by the iLink PRO software).

To re-teach the storage positions, follow the instructions on “Teaching the Twister II Storage Racks” on page 57. After you type the name in the Instrument Name window, you are prompted to discard the previous settings and reteach the instrument. Click the Yes button.

Re-Teaching the Instrument Positions

If you have added material positions to an instrument or if an instrument has been moved slightly and is not properly aligned with the robot, you should re-teach the instrument position. You can teach the instrument positions with the Robot software in either Standalone mode (started from the Windows Start menu) or in Remote mode (started and initialized by the iLink PRO software).

NOTE

If you move an instrument in the system, you must re-teach all of the material positions for that instrument.

To re-teach an instrument position, follow the instructions on “Teaching the Instrument Positions” on page 64. After you type the name in the Instrument Name window, you are prompted to discard the previous settings and reteach the instrument. Click the Yes button.
Adjusting the Instrument Positions

If the robot does not put the materials in the correct position in an instrument, the instrument or robot may have been moved slightly out of position. This can be corrected by correcting the position of the instruments as described below.

1. Place ONE material in the instrument. If adjusting an instrument with a drawer that opens and closes, ensure that the drawer is fully open.
2. Open the robot software in standalone mode. Use the existing positions to move the robot to the instrument position.
3. Move the instrument slightly to enable the robot to properly place the material in the position.

If repositioning the instrument does not solve the problem, you should re-teach the instrument position, as described in “Re-Teaching the Instrument Positions” on page 167.

For problems with rack positions, you should re-teach the rack positions, as described in “Re-Teaching the Storage Positions” on page 167.

If you continue to have problems, contact Caliper Technical Support. See “Contact Us” on page 10 for more information.

Twister II Performance Checks

The procedures in this section are provided to verify whether there are problems with the Twister II arm or grip.

Verify Arm Operation

To verify proper operation of the Twister II arm:

1. From the Robot software main window, use the buttons to move the arm to Rotary, Vertical, Reach, and Wrist positions.
2. If the arm does not move correctly, type the numeric value of the position in the Target Position text box, and try the move again.
3. If the arm still does not move correctly, try using the jog positioning arrows or slide bar, or increment the position using the up and down arrows on the Target Position text box.
4. If the arm still does not move correctly, or moves incorrectly in one direction but not another, contact Caliper Technical Support. See “Contact Us” on page 10 for more information.
Verify Robot Grip Operation

To verify proper operation of the Twister II grip:

1. From the Robot software, use the various controls for the Grip axis to open and close the robot’s grip.

2. If the grip does not open or close correctly, contact Caliper Technical Support. See “Contact Us” on page 10 for more information.

Power Loss During Operation

If you routinely operate the iLink PRO system overnight or with valuable samples, Caliper recommends using a 900-watt (or greater) uninterruptable power supply (UPS) to provide a back-up power source for the robot, the external device(s), and the computer.

If the Twister II robot is powered down during operation, the robot grip loses tension and the arm may drop. Make sure to hold the arm before disconnecting the power.

**WARNING**

*The Twister II arm drops when the Twister II loses power, which may result in spilled liquids if the robot is holding a filled plate. Make sure to hold the Twister II arm when powering down or the material may drop and the contents may spill.*
iLink PRO Utilities Adapter

This section describes how to use the iLink PRO Utilities adapter in an iLink PRO method.

The iLink PRO Utilities adapter enables you to retrieve the values of iLink PRO internal variables (such as Run ID, Application Name, or Resource Name) during a run. Commands to get the current time and to raise alarms are also included.

The iLink PRO Utilities adapter is an IMS (Information Management System) resource. An IMS resource is a “logical” resource used to process and exchange data at run-time. The resource does not occupy a physical space in the automated system. You use iLink PRO variables with the iLink PRO Utilities adapter to transfer data between iLink PRO instructions. The iLink PRO variables hold values that are set at run-time.

The iLink PRO Utilities Adapter resource kit contains an adapter only. The resource kit does not contain an ICP. The iLink PRO Utilities adapter is automatically installed when you install the iLink PRO software. To use the Utilities adapter in a method, you must create a resource that uses the adapter (see “Adding the Resources” on page 41).

Commands

The iLink PRO Utilities adapter provides the following commands to retrieve information from iLink PRO during the run:

- Get Application Name
- Get Resource Name
- Get Results File Path
- Get RunID
- Get Time
- Is Results Output Enabled
- Prompt User
- Raise RollOver Alarm
- Raise User Alarm
- Wait Specified Time

Each of the commands in the iLink PRO Utilities IMS Resource is defined in this section. Each command definition specifies the type and names of the parameters needed for the operation.
Get Application Name

The Get Application Name command returns the name of the iLink PRO method that is currently being executed.

Parameter Descriptions

ApplicationName

Returns the name of the currently running iLink PRO method. The Application Name text box must contain the name of a local String variable that will hold the returned name of the current method.
Get Resource Name

The Get Resource Name command returns the name of the iLink PRO Utilities Resource as defined in the iLink PRO system setup.

Parameter Descriptions

**ResourceName**

Returns the iLink PRO Utilities adapter's resource name as defined in iLink PRO. The Resource Name text box must contain the name of a local String variable that will hold the returned name of the Utilities resource.
Get Results File Path

The Get Results File Path command returns the path where the Resource Data files are saved.

Parameter Descriptions

**ResultsFilePath**

Returns the resource data file path from iLink PRO. The ResultsFilePath text box must contain the name of a local String variable that will hold the returned path for saving the resource data files.
Get Run ID

The Get Run ID command returns the run number of the run currently being executed by iLink PRO.

Parameter Descriptions

CurrentRunID
Returns the run ID number of the run currently being executed. The Current Run ID text box must contain the name of a local Numeric variable that will hold the returned Current Run number.
Get Time

The Get Time command returns the current date and time set on the local computer.

Parameter Descriptions

Date/Time
Returns the current date and time in the format dd-MMM-yyyy;hh:mm:ss. (dd is the day, MMM is the three-letter abbreviation of the month, yyyy is the year, hh is the current hour (0 to 24), mm is minutes, and ss is seconds.) The Data/Time text box must contain the name of a local String variable that will hold the returned current data and time.
Is Results Output Enabled

The Is Results Output Enabled command returns True if the Resource Data files are created by iLink PRO and False if the Resource Data files are not created by iLink PRO. The Resource Data files are always created in iLink PRO.

Parameter Descriptions

**ResultsOutputEnabled**
Returns True if results output is enabled, False if results output is not enabled. Note that this operation does not change the Enabled setting for the Resource Data Files, it only returns the current setting. The ResultsOutputEnabled text box must contain the name of a local String variable that will hold the returned True/False value.
Prompt User

The Prompt User command displays a message box with an OK button during execution that the user must acknowledge before execution can continue. When the Prompt User command is executed in the method, method execution will pause (any commands currently in progress will continue to execute, but no new commands will be executed).

Parameter Descriptions

Message
The text message that will appear in the message box. The title bar of the message box will contain the method name and Run number of the iLink PRO method that is currently running. The user must click the OK button to continue the execution. Note: If used in a scheduled application, the prompts may interleave. The Message text box can contain the actual message text or the name of a local String parameter that can be set to the desired message text at run time.
Raise RollOver Alarm

The Raise RollOver Alarm command raises an alarm when the iLink PRO RunID equals the specified rollover number. You specify the rollover number, the alarm number, and the text for the alarm. The RaiseRolloverAlarm operation can be used in applications where storage capacity is used in a linear fashion and the user must re-load and/or unload the storage resources in the system.

Parameter Descriptions

RollOverValue
The run number when the alarm will be raised. Any number less than or equal to 0 is invalid.

AlarmNumber
The status number for the returned alarm. By convention, the alarm number should be a negative number less than any of the adapter status numbers described in the Status Codes section. 0 is invalid.

AlarmMessage
The text message of the alarm - e.g.: “Presto Carousel Full. Please Empty the Carousel.” The text box can contain either the actual text of the message or a local String parameter that can be set to the desired message text at run time.
Raise User Alarm

The Raise User Alarm command raises an alarm when the operation is executed. You specify the alarm number and the text for the alarm.

Parameter Descriptions

**AlarmNumber**
The status number for the returned alarm. By convention, the alarm number should be a negative number less than any of the adapter status numbers described in the Status Codes section. 0 is invalid.

**AlarmMessage**
The text message of the alarm. The text box can contain either the actual text of the message or a local String parameter that can be set to the desired message text at run time.
Wait Specified Time

The Wait Specified Time command pauses system execution for the specified time. The Method must have Concurrency Disabled for this command to pause the system as desired. (The Concurrency option is located on the ScheduleType tab in the Method Parameters window. To view the method parameters, select View→Method Parameters in the Method Editor window.)

Parameter Descriptions

- **Days**
  The number of days to pause the execution.

- **Hours**
  The number of hours to pause the execution.

- **Minutes**
  The number of minutes to pause the execution.

- **Seconds**
  The number of seconds to pause the execution.

The text boxes can contain either the actual text of the message or a local parameter that can be set to the desired value at run time.
## Status Codes

The iLink PRO Utilities adapter software can return the following status codes:

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Description</th>
<th>Suggested Error Recovery</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1001</td>
<td>Invalid state for performing this function</td>
<td>The action that you are trying to perform is not possible given the current lifecycle state. For example, if you try to invoke an active method before properly initializing the Adapter.</td>
<td>Make sure you started the adapter in remote mode using iLink PRO.</td>
</tr>
<tr>
<td>-1002</td>
<td>Feature Not Implemented by the ICP</td>
<td>You are trying to do something that is not supported by the ICP. For example, you are trying to use ICP level simulation when it is not supported.</td>
<td>Use only supported features and use cases.</td>
</tr>
<tr>
<td>-1003</td>
<td>The invoked operation is not known</td>
<td>You are trying to use an operation that is not known by the adapter, i.e. other than the operations listed in this section.</td>
<td>Use only supported features and use cases.</td>
</tr>
<tr>
<td>-1004</td>
<td>Incorrect parameters for the invoked operation</td>
<td>The parameters passed for the operation are incorrect.</td>
<td>Check documentation to verify the parameters being passed are of the correct type.</td>
</tr>
<tr>
<td>-1005</td>
<td>The Plug and Play file does not exist: &lt;FileName&gt;</td>
<td>The iLink Plug and Play file indicated by <code>&lt;FileName&gt;</code> does not exist.</td>
<td>Make sure the Caliper Plug and Play XML file is in the same directory as the EXE file and has the same name as the EXE. Contact Caliper Technical Support for details. See “Contact Us” on page 10.</td>
</tr>
<tr>
<td>-1006</td>
<td>Error reading Plug and Play information</td>
<td>iLink PRO was unable to extract the adapter information for the resource.</td>
<td>Contact Caliper Technical Support. See “Contact Us” on page 10.</td>
</tr>
</tbody>
</table>
Notification Utility

This section describes how to use the Notification Utility commands in an iLink PRO method.

The Notification Utility enables you to add instructions to an iLink PRO method that will send an email, dial a phone number on the computer’s modem, and/or run an executable file when the method is running. This enables you to notify someone remotely at a certain point in the method or to run an executable file during method execution.

The Notification Utility adapter is an IMS (Information Management System) resource. An IMS resource is a “logical” resource used to process and exchange data at run-time. The resource does not occupy a physical space in the automated system.

The Notification Utility resource kit contains an adapter and an ICP. The Notification Utility adapter and ICP are automatically installed when you install the iLink PRO software. To use the Notification Utility commands in a method, you must create a resource that uses the adapter (see “Adding the Resources” on page 41).

This section describes how to use the Notification Utility commands in a method and how to set up and save the Notification files.

Commands

The Notification Utility provides the following commands to send notifications during the run:

- Call Number
- Email
- Email with Attachment
- Notify
- Run Program

Each of the commands in the Notification Utility IMS Resource is defined in this section. Each command definition describes the parameters needed for the command.
Call Number Command

The Call Number command dials the specified phone number on the default modem on the computer.

Phone Number
The number sequence to call. Type a comma (,) to pause for approximately 2 seconds between numbers, if needed. You can use numbers 0 through 9, parentheses, spaces, and dashes in the Numbers text box. Parentheses, spaces and dashes are ignored. Separate multiple phone numbers with a semi-colon (;).

Figure 122. Notify Command Window
Email Command

The Email command sends an email to the specified email addresses.

![Figure 123. Notify Command Window](image)

**Email Address**
The email addresses to send the email to. Separate multiple email addresses with a semi-colon (;) without spaces between the addresses.

**Subject**
The text for the Subject of the email.

**Message**
The text for the body of the email.
Email with Attachment Command

The Email with Attachment command sends an email with the specified attached file to the specified email addresses.

![Figure 124. Notify Command Window](image)

**Email Address**
The email addresses to send the email to. Separate multiple email addresses with a semi-colon (;) without spaces between the addresses.

**Subject**
The text for the Subject of the email.

**Message**
The text for the body of the email.

**Path and File Name**
The path and file name of the document (including file extension) that you want to attach to the email. Separate multiple files with a semi-colon (;).
Notify Command

The Notify command performs the operations in the specified notification file.

Before you can add the Notify command to an iLink PRO method, you must create and save a notification file with the desired name and settings. If you have not created the notification file, see “Creating a Notification File” on page 187.

![Figure 125. Notify Command Window](image)

**File Name**
Select or type the path and name of the notification file that you want to execute, including the .nfy extension (for example: C:\Data\Method1Notify.nfy).
Creating a Notification File

This section describes how to create a notification file that is used by the Notify command.

To create a notification file:

1 Open the Notification ICP:
   - If iLink PRO is running and the Notification Utility has been added to the system setup, the Notification ICP will already be running. Click the **Notification Utility** button on the Windows task bar at the bottom of the screen.
   - If iLink PRO is not running or the Notification Utility has not been added to the system setup, start the Notification ICP by selecting **Start → Programs → Caliper Life Sciences → Instruments → Notification Utility → Notification Utility**

The Notification Utility main window opens as shown in Figure 126.

![Figure 126. Notification Utility Main Window](image)

2 Complete the desired sections of the notification to email, dial a phone number, or run an executable as described below. Clear the text boxes for the options you do not want to use.
Creating a Notification File (Continued)

3 To send an email:
   a Type the desired email addresses in the Addresses text box. Separate multiple email addresses with a semi-colon (;) without spaces between the addresses. If you do not want to send email, delete the text from the Addresses text box.
   b Type the desired subject for the email in the Subject text box.
   c Type the desired text for the email in the Message text box.
   d If you want to attach a file to the email, click the Attachments button and select the desired file.

4 To dial a phone number:
   a Type the number sequence to call in the Numbers text box. Type a comma (,) to pause for approximately 2 seconds between numbers, if needed. You can use numbers 0 through 9, parentheses, spaces, and dashes in the Numbers text box. Parentheses, spaces and dashes are ignored. Separate multiple phone numbers with a semi-colon (;).
   b If desired, click the Test Modem button to dial the number displayed.

5 To run a program:
   a Type the path and file name of the program (including file extension) in the Programs text box or click the Programs button to browse for the file. Separate multiple files with a semi-colon (;).

6 Click the Save or Save As button to display the Save or Save As window (see Figure 127 on page 189).
Creating a Notification File (Continued)

7 Navigate to the folder where you want to save the Notification file.

8 Type the desired name for the notification file in the File Name text box and click the Save button.
Run Program Command

The Run Program command runs the specified program file.

![Figure 128. Notify Command Window](image)

**Path and File Name**
The path and file name of the program (including file extension) that you want to run. Separate multiple files with a semi-colon (;).

**Programs button**
Opens the Browse window to browse for the program file.
Simulation Storage Adapters

This section describes how to use the Simulation Storage Adapters (SimFixedStorage and SimRandomStorage) in an iLink PRO method.

SimFixedStorage

Use the SimFixedStorage Adapter to create a Storage resource that holds a fixed number of materials, one material in each plate location. An example of a fixed storage resource is a Lid Parking Station that has 5 locators, where each locator can hold one lid.

When creating the resource (see “Adding the Resources” on page 41) in the System Setup:

1. On the **Settings** tab, change the **Capacity** to the total number of materials that the storage instrument can hold.

2. On the **Properties** tab, change the **Minimum Number of Plate Locators** to the number of plate locations (the same as the capacity).

3. Select the **Fixed Number of Plate Locators** check box.

4. Click the **OK** button to save the changes.

If you are using the SimFixedStorage to represent a physical plate storage location in the system, you must teach each of the plate locations. If the instrument has 5 plate locations, you must teach all 5 plate locations.

When you drag a material into the Fixed Storage instrument in the system layout to create a move instruction, the robot will move the material to the position number where the material was dropped.

For example, if you drop a microplate onto storage position 4, the robot will move to the robot position taught for storage position 4.
SimRandomStorage

Use the SimRandomStorage Adapter to create a Storage resource that has one position to pick or place the material, then the material is moved into the resource and put into the next available position in the instrument. As more materials are added to the instrument, additional empty locators are displayed to hold additional materials. An example of a random storage resource is an incubator that has 1 plate locator for accessing the materials, and any number of materials can be placed inside the incubator.

The SimRandomStorage adapter can also be used to drop materials into a Waste location.

When creating the resource (see “Adding the Resources” on page 41) in the System Setup:

1. On the Settings tab, change the Capacity to the total number of materials that the storage instrument can hold.

2. On the Properties tab, change the Minimum Number of Plate Locators to the number of plate locations you want displayed in the Initial Material Setup.

3. Clear the Fixed Number of Plate Locators check box.

4. Click the OK button to save the changes.

If you are using the SimRandomStorage to represent a physical plate storage location in the system, you only teach one plate location. Note that the SimRandomStorage adapter does not control any hardware. Use the adapter written for the instrument to control the hardware.

When you drag a material into the Random Storage instrument in the system layout to create a move instruction, the robot will move the material to position 1. The Material icon will move to the next empty locator in the instrument diagram, and if all locators contain plates, an empty locator displays at the right side of the instrument diagram. You may have to use the scroll bar to view the empty locator.

For example, if you drop a microplate onto storage position 4, the robot will move to the robot position taught for storage position 1, and if there are no other materials in the instrument, the material icon will display in location 1. (If there are other material icons in the instrument, the material icon displays in the next available empty location.)
Twister II - Specifications

This section contains the instrument dimensions, details, performance and needs.

General Instrument Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Capacity</td>
<td>Up to 39 microplates (without lids) per rack</td>
</tr>
<tr>
<td>Materials Supported</td>
<td>96-well and 384-well plates made by Corning, Nunc, Falcon, or Greiner</td>
</tr>
<tr>
<td></td>
<td>96-deepwell plates made by Corning, Beckman, or Greiner</td>
</tr>
<tr>
<td></td>
<td>96-well filter plates made by Millipore or Packard</td>
</tr>
<tr>
<td></td>
<td>1536-well plates made by Corning or Nunc</td>
</tr>
<tr>
<td></td>
<td>Caliper Automation Certified 200uL Pipet Tips</td>
</tr>
<tr>
<td></td>
<td>Caliper Automation Certified 100uL Pipet Tips</td>
</tr>
<tr>
<td></td>
<td>Caliper Automation Certified 25uL Pipet Tips</td>
</tr>
<tr>
<td>Handling Format</td>
<td>Places plates in portrait or landscape position</td>
</tr>
<tr>
<td>Plate Storage</td>
<td>Maximum 3 pods with 3 removable racks per pod</td>
</tr>
<tr>
<td>PC Interface</td>
<td>RS-232 serial</td>
</tr>
</tbody>
</table>

Robotic Arm

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotary Travel</td>
<td>$340^\circ$</td>
</tr>
<tr>
<td>Horizontal Reach</td>
<td>8.5 inch span, 11.25 inches from the robot to</td>
</tr>
<tr>
<td></td>
<td>19.75 inches away from the robot</td>
</tr>
<tr>
<td>Vertical Travel</td>
<td>22.75 inch span, 7 inches from the base to</td>
</tr>
<tr>
<td></td>
<td>29.75 inches from the base</td>
</tr>
</tbody>
</table>

Physical Performance

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotary</td>
<td>Servo Motor</td>
</tr>
<tr>
<td>Vertical</td>
<td>Servo Motor</td>
</tr>
<tr>
<td>Home Position</td>
<td>Optical sensors for rotary and vertical arm home positions</td>
</tr>
</tbody>
</table>
Environmental

Harmonized standards met:

<table>
<thead>
<tr>
<th>Standard</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN 61010-1:2001</td>
<td>Electrical Safety</td>
</tr>
<tr>
<td>EN 55011 (1995)</td>
<td>EMI for Industrial, Scientific and Medical Equipment</td>
</tr>
<tr>
<td>Altitude</td>
<td>Up to 3000M</td>
</tr>
<tr>
<td>General</td>
<td>Indoor Use Only</td>
</tr>
</tbody>
</table>

* Amendment 2

Physical

Size (H x W x D) 40 in (101.5 cm) wide
40 in (101.5 cm) deep
37 in (94 cm) high

Weight 50 lbs. (22.7 kg)

Electrical

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrical Voltage</td>
<td>100/120/240V AC</td>
</tr>
<tr>
<td>Line Frequency</td>
<td>50/60 Hz</td>
</tr>
<tr>
<td>Fuses</td>
<td>100/120V operation: One 3A, 0.25 in x 1.25 in, Fast-Acting</td>
</tr>
<tr>
<td></td>
<td>240V operation: Two 1.6A, 5.2mm x 20mm, SLO-BLO</td>
</tr>
<tr>
<td>Grounding</td>
<td>Through the power cord</td>
</tr>
</tbody>
</table>
Index

A
Abort Move button ............................................. 144
Absolute position ........................................... 33
Adapter software
definition .................................................. 24
purpose of ..................................................... 36
AdapterInterface22.tlb ........................................ 55
Adding
instructions to the method .................................. 91, 93
instruments ...................................................... 41
materials after saving ........................................ 107
materials to a method ......................................... 79
resources to system setup ..................................... 41
Adjusting methods ............................................. 117
Alarm
definition for operators ...................................... 23
notification utility ............................................... 182
Alarms pane ...................................................... 164
All Runs
definition for integrators .................................... 28
Altitude specifications ......................................... 194
Arm
reach .............................................................. 147
vertical ............................................................ 147
Audience .......................................................... 19
Axis
definitions ....................................................... 147
grip ................................................................. 148
reach ............................................................... 147
rotary .............................................................. 148
vertical ............................................................ 147
wrist ................................................................. 148

C
Caliper Center for Training and Development ........... 11
Caliper Consumables database ................................ 28
Call Number command .......................................... 183
Canister ........................................................... 149
Changing
fuses .............................................................. 159
operation parameters .......................................... 106
parameters ....................................................... 140
Cleaning
rack base .......................................................... 158
Twister II .......................................................... 158
Clearance position ............................................... 33
ClickYes ........................................................... 166
Closing
iLink PRO software ............................................ 145
Method Editor window ......................................... 123, 130
Color of resource in Gantt chart .............................. 114
Comments
adding resource .................................................. 95
Communication port on pod .................................... 155
Communications cable
disconnecting ...................................................... 160
hardware description .......................................... 157
Component Names .............................................. 53
Concurrency
definition ...................................................... 29
selecting ........................................................... 90
Conditional execution
definition ........................................................ 28
settings ............................................................ 96
Continuing a run .................................................. 143
Copying an instruction .......................................... 106
Creating
method set ........................................................ 126
new method ....................................................... 77
new resource ..................................................... 41
notification files ................................................ 187
system setup ..................................................... 38
Customer Support plans ........................................ 10
Data Configuration
creating new ...................................................... 99
using ............................................................... 104
Data Utility
operations ........................................................ 170
status codes ...................................................... 181
DCOM .............................................................. 46
Defining lids ....................................................... 31
Delay Before Being Picked .................................... 97, 117
Delay time format ............................................... 97
Deleting an instruction ......................................... 106
Deleting materials from a method ............................ 107
Device positions
adjusting .......................................................... 168
re-teaching ........................................................ 167
teaching .................................. 64
Dial a phone number
  during a method ..................... 187
  on alarm .............................. 121
Drive mode
  definition ............................ 29
  selecting ............................ 90
Duration time format .................. 97

E
Editing
  materials ............................ 79
  method ................................ 106
  method set ........................... 129
Electrical specifications ............ 194
Electrical voltage specification .... 194
Email
  send during a method .............. 187
  send on alarm ....................... 121
Email command ....................... 184
Email with Attachment command .... 185
End Now button ....................... 144
Ending the run immediately .......... 144
Enforce Sequential Setup ........... 118
Environmental specifications ....... 194
Error
  recovery ............................ 164
  types ................................ 23
Event Driven .......................... 90
Every Nth Run ......................... 98
  definition for integrators ........ 28
Excel Data file, creating ........... 99
Excel DirectLink name ............... 42
Executable file
  run during a method .............. 187
  run on alarm ....................... 121
Executing a method ................. 131
Execution
  pausing ............................. 143
  resuming ............................ 143
  starting ............................ 141
  stopping ............................ 144
Exporting methods ................... 124

F
Features
  for operators ....................... 21
File sharing .......................... 55
Finishing the current run ........... 144
Firewall .............................. 54
Fuse
  block ................................ 160
  changing ............................ 159
  location ............................. 155
  specifications ....................... 194

G
Gantt chart
  comparing methods ................. 114
  opening method ..................... 113
  resource color ...................... 114
  settings ............................ 115
  viewing scheduled method ........ 112
General environment specifications 194
General instrument specifications . 193
GetApplicationName ................. 171
GetResourceName ...................... 172
GetResultsFilePath .................. 173
GetRunID .............................. 174
GetTime ............................... 175
Grip
  cleaning ............................ 158
  Grip axis ............................ 148
  Grounding specifications .......... 194

H
Handle on rack ......................... 156
Handling Format ...................... 193
Hardware ............................. 146
Home position sensors .............. 193
Horizontal reach ..................... 193

I
ICP
  definition for integrators .......... 24
  definition for operators .......... 21
  purpose of ........................ 36
iLink PRO
  terminology for integrators ....... 24
  terminology for operators ......... 21
iLink PRO software
  closing ............................. 145
  starting ............................ 132
Importing methods ................... 124
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMS resource</td>
<td>25</td>
</tr>
<tr>
<td>In parameters</td>
<td>26</td>
</tr>
<tr>
<td>Incubator storage setup</td>
<td>109</td>
</tr>
<tr>
<td>INI file</td>
<td></td>
</tr>
<tr>
<td>instruments</td>
<td>31</td>
</tr>
<tr>
<td>robot</td>
<td>35</td>
</tr>
<tr>
<td>Initial Layout</td>
<td>79</td>
</tr>
<tr>
<td>Initial material position, setting</td>
<td>109</td>
</tr>
<tr>
<td>Initializing instruments</td>
<td>166</td>
</tr>
<tr>
<td>Instruction</td>
<td></td>
</tr>
<tr>
<td>adding Move</td>
<td>92</td>
</tr>
<tr>
<td>adding to method</td>
<td>91,93</td>
</tr>
<tr>
<td>changing parameters</td>
<td>106</td>
</tr>
<tr>
<td>copying</td>
<td>106</td>
</tr>
<tr>
<td>deleting</td>
<td>106</td>
</tr>
<tr>
<td>duration</td>
<td>91,95</td>
</tr>
<tr>
<td>pasting</td>
<td>106</td>
</tr>
<tr>
<td>setting duration</td>
<td>97</td>
</tr>
<tr>
<td>Instrument</td>
<td></td>
</tr>
<tr>
<td>adding to system setup</td>
<td>41</td>
</tr>
<tr>
<td>adjusting positions</td>
<td>168</td>
</tr>
<tr>
<td>INI file name</td>
<td>31</td>
</tr>
<tr>
<td>initializing</td>
<td>166</td>
</tr>
<tr>
<td>naming</td>
<td>42</td>
</tr>
<tr>
<td>on remote computer</td>
<td>46</td>
</tr>
<tr>
<td>setting simulation mode</td>
<td>119</td>
</tr>
<tr>
<td>turning on</td>
<td>131</td>
</tr>
<tr>
<td>Instrument Dimensions</td>
<td>193</td>
</tr>
<tr>
<td>Instrument method</td>
<td>21,24</td>
</tr>
<tr>
<td>Instrument positions</td>
<td></td>
</tr>
<tr>
<td>re-teaching</td>
<td>167</td>
</tr>
<tr>
<td>teaching</td>
<td>64</td>
</tr>
<tr>
<td>Integrating the system</td>
<td>38</td>
</tr>
<tr>
<td>Integration</td>
<td></td>
</tr>
<tr>
<td>overview</td>
<td>38</td>
</tr>
<tr>
<td>system setup</td>
<td>38</td>
</tr>
<tr>
<td>Integrator</td>
<td></td>
</tr>
<tr>
<td>training required</td>
<td>20</td>
</tr>
<tr>
<td>Intended audience</td>
<td>19</td>
</tr>
<tr>
<td>Interleaving materials</td>
<td>109</td>
</tr>
<tr>
<td>Introduction</td>
<td>19</td>
</tr>
<tr>
<td>IsResultsOutputEnabled</td>
<td>176</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Layout window</td>
<td>135</td>
</tr>
<tr>
<td>Lids</td>
<td></td>
</tr>
<tr>
<td>defining</td>
<td>31</td>
</tr>
<tr>
<td>filling racks</td>
<td>136</td>
</tr>
<tr>
<td>setting up storage config</td>
<td>81</td>
</tr>
<tr>
<td>Line frequency specifications</td>
<td>194</td>
</tr>
<tr>
<td>Loading materials</td>
<td>135</td>
</tr>
<tr>
<td>Location problems</td>
<td>163</td>
</tr>
<tr>
<td>Locator Notch</td>
<td>138</td>
</tr>
<tr>
<td>Log</td>
<td></td>
</tr>
<tr>
<td>Runtime log file</td>
<td>145</td>
</tr>
<tr>
<td>Long-term shutdown</td>
<td>161</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>Macros</td>
<td>34</td>
</tr>
<tr>
<td>Maintenance</td>
<td>158</td>
</tr>
<tr>
<td>Material</td>
<td></td>
</tr>
<tr>
<td>adding after saving</td>
<td>107</td>
</tr>
<tr>
<td>adding Move</td>
<td>92</td>
</tr>
<tr>
<td>adding to the method</td>
<td>79</td>
</tr>
<tr>
<td>defining storage setup</td>
<td>109</td>
</tr>
<tr>
<td>definition for integrators</td>
<td>28</td>
</tr>
<tr>
<td>definition for operators</td>
<td>23</td>
</tr>
<tr>
<td>deleting</td>
<td>107</td>
</tr>
<tr>
<td>putting into the racks</td>
<td>135</td>
</tr>
<tr>
<td>supported types</td>
<td>193</td>
</tr>
<tr>
<td>Material location problems</td>
<td>163</td>
</tr>
<tr>
<td>Material Positions list</td>
<td>135</td>
</tr>
<tr>
<td>Method</td>
<td></td>
</tr>
<tr>
<td>adding instructions</td>
<td>91,93</td>
</tr>
<tr>
<td>adding materials</td>
<td>79</td>
</tr>
<tr>
<td>adjusting</td>
<td>117</td>
</tr>
<tr>
<td>comparing in Gantt chart</td>
<td>114</td>
</tr>
<tr>
<td>creating</td>
<td>76</td>
</tr>
<tr>
<td>creating new</td>
<td>77</td>
</tr>
<tr>
<td>definition for operators</td>
<td>22</td>
</tr>
<tr>
<td>editing</td>
<td>106</td>
</tr>
<tr>
<td>exporting</td>
<td>124</td>
</tr>
<tr>
<td>importing</td>
<td>124</td>
</tr>
<tr>
<td>instrument</td>
<td>21</td>
</tr>
<tr>
<td>opening</td>
<td>105,133</td>
</tr>
<tr>
<td>opening new</td>
<td>77</td>
</tr>
<tr>
<td>overview</td>
<td>76</td>
</tr>
<tr>
<td>running</td>
<td>131</td>
</tr>
<tr>
<td>running from the Method Editor</td>
<td>124</td>
</tr>
<tr>
<td>saving</td>
<td>108</td>
</tr>
<tr>
<td>scheduling</td>
<td>108</td>
</tr>
<tr>
<td>scheduling options</td>
<td>90</td>
</tr>
<tr>
<td>sequencing</td>
<td>108</td>
</tr>
<tr>
<td>Method directory, default</td>
<td>118</td>
</tr>
</tbody>
</table>
Method Editor window
   closing ........................................ 123, 130
   opening ....................................... 77
Method set
   creating ...................................... 126
   definition for operators ................... 22
   editing ........................................ 129
   opening ....................................... 133
   overview ...................................... 126
   saving ......................................... 130
Method Set Editor window
   opening ........................................ 127
Microplate position
   loading plates ................................ 136
   portrait and landscape ..................... 148
Move
   adding ........................................... 91
   choosing material ............................. 92
Moving the Twister II ......................... 160
Multiple position, teaching
   Instrument ..................................... 75
N
Name
   specifying instrument ...................... 42
   Twister II racks ............................. 42
New
   data configuration ............................ 99
   method ......................................... 77
   system setup .................................. 38
Notification Utility .......................... 182
   creating notification files ................ 187
   name ........................................... 42
Notifications ................................... 121
   definition ..................................... 23
Notify command .................................. 186
O
Opening
   iLink PRO software ........................... 132
   method ......................................... 105, 133
   Method Set Editor window ................... 127
   new method .................................... 77
Opening Method set ............................ 133
Operation
   adding to method ............................. 93
   for processing resources .................... 25
   Operation parameters ....................... 25
   Operator
      features ..................................... 21
      training required .......................... 20
   Optimizing the run ........................... 117
   Optional Twister II components ............ 157
   Options, setting .............................. 118
   Out parameters ................................ 26
   Outlook error message ....................... 166
   Overview
      Hardware ..................................... 146
      Integration .................................. 38
      Operation .................................... 131
      teaching ..................................... 57
      Troubleshooting ............................ 162
P
   Packing materials ............................ 160
Parameters
   changing ....................................... 106, 140
   defining ....................................... 88
   definition for operators .................... 22
   example ........................................ 26
   Paste ........................................... 106
   Pasting an instruction ....................... 106
   Paths, definition ............................. 34
   Pause button .................................. 143
   Pausing the run ................................ 143
   Physical performance specifications .... 193
   Physical specifications ..................... 194
   Pick position .................................. 32
   PickClearance position ...................... 33
   Place position ................................ 32
   PlaceClearance position ..................... 33
   Plate capacity ................................ 193
   Plate storage .................................. 193
   Plates with lids ............................... 31
   Pod
      cap screw .................................... 154
      exterior front view ......................... 151
      exterior rear view ......................... 152
      hardware .................................... 150
      hardware overview ......................... 146
      interior view ................................ 154
      loading racks ............................... 138
      locking pin screws ......................... 154
      rack position numbers ..................... 150
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>securing location</td>
<td>152</td>
</tr>
<tr>
<td>top view</td>
<td>153</td>
</tr>
<tr>
<td>pos file, robot</td>
<td>35</td>
</tr>
<tr>
<td>Positions</td>
<td></td>
</tr>
<tr>
<td>definition</td>
<td>32</td>
</tr>
<tr>
<td>teaching device positions</td>
<td>64, 167</td>
</tr>
<tr>
<td>teaching instrument positions</td>
<td>64, 167</td>
</tr>
<tr>
<td>teaching rack positions</td>
<td>57, 167</td>
</tr>
<tr>
<td>types</td>
<td>33</td>
</tr>
<tr>
<td>Power cord</td>
<td>157</td>
</tr>
<tr>
<td>Power Entry Port/Fuse Assembly</td>
<td>155</td>
</tr>
<tr>
<td>Power loss during operation</td>
<td>169</td>
</tr>
<tr>
<td>Procedure file</td>
<td>34</td>
</tr>
<tr>
<td>Processing resource</td>
<td></td>
</tr>
<tr>
<td>definition</td>
<td>25</td>
</tr>
<tr>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>running during a method</td>
<td>190</td>
</tr>
<tr>
<td>running on alarm</td>
<td>121</td>
</tr>
<tr>
<td>PromptUser</td>
<td>177</td>
</tr>
</tbody>
</table>

**R**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack</td>
<td></td>
</tr>
<tr>
<td>handles</td>
<td>156</td>
</tr>
<tr>
<td>hardware overview</td>
<td>146</td>
</tr>
<tr>
<td>Locator Notch</td>
<td>138</td>
</tr>
<tr>
<td>material layout multiple materials</td>
<td>82</td>
</tr>
<tr>
<td>material layout single materials</td>
<td>80</td>
</tr>
<tr>
<td>name</td>
<td>42</td>
</tr>
<tr>
<td>parts and functions</td>
<td>156</td>
</tr>
<tr>
<td>putting materials into</td>
<td>135</td>
</tr>
<tr>
<td>putting onto the Twister II pod</td>
<td>138</td>
</tr>
<tr>
<td>re-stacking</td>
<td>30</td>
</tr>
<tr>
<td>re-teaching positions</td>
<td>57, 167</td>
</tr>
<tr>
<td>RaiseRollOverAlarm</td>
<td>178</td>
</tr>
<tr>
<td>RaiseUserAlarm</td>
<td>179</td>
</tr>
<tr>
<td>Reach axis</td>
<td>147</td>
</tr>
<tr>
<td>Recently used methods</td>
<td>118</td>
</tr>
<tr>
<td>Recovering from an error</td>
<td>164</td>
</tr>
<tr>
<td>Registry key</td>
<td>54</td>
</tr>
<tr>
<td>Relative position</td>
<td>33</td>
</tr>
<tr>
<td>Remote computer</td>
<td>46</td>
</tr>
<tr>
<td>Remote mode</td>
<td>24, 36</td>
</tr>
<tr>
<td>Remote resource</td>
<td></td>
</tr>
<tr>
<td>adding</td>
<td>56</td>
</tr>
<tr>
<td>Replacing fuses</td>
<td>159</td>
</tr>
<tr>
<td>Resource</td>
<td></td>
</tr>
<tr>
<td>adding</td>
<td>41</td>
</tr>
<tr>
<td>adding comments</td>
<td>95</td>
</tr>
<tr>
<td>adding new</td>
<td>39</td>
</tr>
<tr>
<td>adding to system setup</td>
<td>41</td>
</tr>
<tr>
<td>initializing</td>
<td>166</td>
</tr>
<tr>
<td>naming</td>
<td>42</td>
</tr>
<tr>
<td>Resource Operation</td>
<td></td>
</tr>
<tr>
<td>adding to method</td>
<td>93</td>
</tr>
<tr>
<td>Resource type, definition</td>
<td>25</td>
</tr>
<tr>
<td>Restacking</td>
<td>30</td>
</tr>
<tr>
<td>Resuming the run</td>
<td>143</td>
</tr>
<tr>
<td>Robot</td>
<td></td>
</tr>
<tr>
<td>canister</td>
<td>149</td>
</tr>
<tr>
<td>check arm operation</td>
<td>168</td>
</tr>
<tr>
<td>check grip operation</td>
<td>169</td>
</tr>
<tr>
<td>files</td>
<td>35</td>
</tr>
<tr>
<td>hardware for operators</td>
<td>146</td>
</tr>
<tr>
<td>hardware overview</td>
<td>146</td>
</tr>
<tr>
<td>INI file</td>
<td>35</td>
</tr>
<tr>
<td>paths</td>
<td>34</td>
</tr>
<tr>
<td>position types</td>
<td>33</td>
</tr>
<tr>
<td>positions</td>
<td>32</td>
</tr>
<tr>
<td>software terminology</td>
<td>32</td>
</tr>
<tr>
<td>teaching</td>
<td>57</td>
</tr>
<tr>
<td>Robot axes</td>
<td>147</td>
</tr>
<tr>
<td>Robot procedure</td>
<td>34</td>
</tr>
<tr>
<td>Robotic arm specifications</td>
<td>193</td>
</tr>
<tr>
<td>Rotary axis</td>
<td>148</td>
</tr>
<tr>
<td>Rotary motors</td>
<td>193</td>
</tr>
<tr>
<td>Rotary travel</td>
<td>193</td>
</tr>
<tr>
<td>Run</td>
<td></td>
</tr>
<tr>
<td>pausing</td>
<td>143</td>
</tr>
<tr>
<td>resuming</td>
<td>143</td>
</tr>
<tr>
<td>starting</td>
<td>141</td>
</tr>
<tr>
<td>stopping</td>
<td>144</td>
</tr>
<tr>
<td>stopping immediately</td>
<td>144</td>
</tr>
<tr>
<td>Run program</td>
<td></td>
</tr>
<tr>
<td>on alarm</td>
<td>121</td>
</tr>
<tr>
<td>Run Program command</td>
<td>190</td>
</tr>
<tr>
<td>Run Range</td>
<td></td>
</tr>
<tr>
<td>definition for integrators</td>
<td>28</td>
</tr>
<tr>
<td>setting</td>
<td>99</td>
</tr>
<tr>
<td>Running a method</td>
<td>131</td>
</tr>
<tr>
<td>Runs, scheduling/sequencing</td>
<td>108</td>
</tr>
<tr>
<td>Run-Time Conditional Execution</td>
<td>29</td>
</tr>
<tr>
<td><strong>S</strong></td>
<td><strong>T</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Safe position</td>
<td>Teach plate</td>
</tr>
<tr>
<td>Saving</td>
<td>Teach Wizard</td>
</tr>
<tr>
<td>method</td>
<td>instrument</td>
</tr>
<tr>
<td>method set</td>
<td>rack</td>
</tr>
<tr>
<td>system setup</td>
<td>terminology</td>
</tr>
<tr>
<td>Schedule</td>
<td>Teaching</td>
</tr>
<tr>
<td>viewing Gantt chart</td>
<td>device positions</td>
</tr>
<tr>
<td>Scheduling</td>
<td>instrument positions</td>
</tr>
<tr>
<td>definition</td>
<td>rack positions</td>
</tr>
<tr>
<td>method</td>
<td>Sciclone</td>
</tr>
<tr>
<td>setting options</td>
<td>name</td>
</tr>
<tr>
<td>Service plans</td>
<td>Text data file, creating</td>
</tr>
<tr>
<td>Shipping carton</td>
<td>Time Driven</td>
</tr>
<tr>
<td>Shutting down the system</td>
<td>Training</td>
</tr>
<tr>
<td>SimFixedStorage</td>
<td>required for integrators</td>
</tr>
<tr>
<td>SimRandomStorage</td>
<td>required for operators</td>
</tr>
<tr>
<td>SimReader</td>
<td>Twister II</td>
</tr>
<tr>
<td>name</td>
<td>cleaning</td>
</tr>
<tr>
<td>Simulation</td>
<td>hardware for operators</td>
</tr>
<tr>
<td>setting instruments</td>
<td>long term shutdown</td>
</tr>
<tr>
<td>Simulation adapters</td>
<td>maintenance</td>
</tr>
<tr>
<td>Simulation Adapters, name</td>
<td>moving</td>
</tr>
<tr>
<td>Size specifications</td>
<td>name</td>
</tr>
<tr>
<td>Software architecture</td>
<td>performance specifications</td>
</tr>
<tr>
<td>Software communication</td>
<td>racks included</td>
</tr>
<tr>
<td>Specifications</td>
<td>Status codes, iLink PRO Data Utility</td>
</tr>
<tr>
<td>electrical</td>
<td>Stopping the robot immediately</td>
</tr>
<tr>
<td>environmental</td>
<td>Storage</td>
</tr>
<tr>
<td>general instrument</td>
<td>teaching positions</td>
</tr>
<tr>
<td>physical</td>
<td>Storage resource</td>
</tr>
<tr>
<td>robotic arm</td>
<td>Storage Setup</td>
</tr>
<tr>
<td>Spills, cleaning up</td>
<td>Support plans</td>
</tr>
<tr>
<td>Standalone mode</td>
<td>System Integration</td>
</tr>
<tr>
<td>Starting</td>
<td>System Setup</td>
</tr>
<tr>
<td>Editor software</td>
<td>creating</td>
</tr>
<tr>
<td>iLink PRO software</td>
<td>definition for integrators</td>
</tr>
<tr>
<td>Method Set Editor</td>
<td>overview</td>
</tr>
<tr>
<td>the run.</td>
<td>saving</td>
</tr>
<tr>
<td>Turning off the system</td>
<td>System Setup window, opening</td>
</tr>
<tr>
<td>Turning the system on</td>
<td>Teaching</td>
</tr>
<tr>
<td>moving</td>
<td>device positions</td>
</tr>
<tr>
<td>Twister II</td>
<td>instrument positions</td>
</tr>
<tr>
<td>cleaning</td>
<td>rack positions</td>
</tr>
<tr>
<td>hardware for operators</td>
<td>Sciclone</td>
</tr>
<tr>
<td>long term shutdown</td>
<td>name</td>
</tr>
<tr>
<td>maintenance</td>
<td>performance specifications</td>
</tr>
<tr>
<td>moving</td>
<td>racks included</td>
</tr>
</tbody>
</table>

P/N 112580 Rev. 0  iLink PRO User's Manual  Caliper Life Sciences, Inc.
Specifications ............... 193
weight ....................... 194
Twister II racks name ............. 42
TwisterII
   performance checks .......... 168

U
UPS ......................... 169
Utilities adapter ............. 170

V
Variables
   defining ...................... 86
   definition for integrators .... 27
   definition for operators ....... 22
VBA, using VBA editor .......... 34
Vertical axis .................. 147
Vertical motors ............... 193
Vertical travel ............... 193
Visual Basic Application
   using VBA editor ............ 34

W
WaitSpecifiedTime .............. 180
Weight specifications .......... 194
Well A1 location ............... 136
Wizard
   Instrument Teach ............ 64, 167
   Rack Teach .................. 57, 167
Wrist axis .................... 148

X
XML data file, creating ........ 99
xpd file, robot ............... 35